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Preface

This documentation describes how to test business services, subprograms, subroutines, and maps
in the NaturalONE environment. It is organized under the following headings:

Release Notes

Information on new features and enhancements.

Prerequisites

Prerequisites for application testing.

Getting Started

A brief introduction to application testing. How to test a simple
subprogram, how to save it as a unit test file, and how to generate
an Ant script from the unit test file.

Features of the Test Editors

Describes the features of the test editors for business services and
subprogram, such as navigation options and toolbar icons.

Test a Business Service or
Subprogram Directly

How to run a business service or subprogram by analyzing the
parameters in a test editor.

Create a Unit Test for a Business
Service or Subprogram

How to create a Natural unit test for a business service or
subprogram.

Create an External Data Unit Test

How to create a unit test that accepts input and/or validations from
a CSV file.

Create a Sequence Unit Test

How to create a special type of unit test that executes a sequence
of test steps in a specified order.

Test an External Subroutine

How to test an external subroutine using either a subprogram or a
program that calls a subprogram.

Test a Natural Map

How to test a map as you would on the server.

Setting Preferences for Application
Testing

Describes the preferences you can set for the test functions, such as
setting preferences for logging unit test results and synchronizing
local resources with those on the server.

Creating Ant Scripts to Run Unit Tests

How to create XML-based Ant scripts to run unit test files.
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

Product Training

You can find helpful product training material on our Learning Portal at https://learn.software-

ag.com.

Tech Community

You can collaborate with Software GmbH experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:
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About this Documentation

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software GmbH news and announcements.

® Explore our communities.

® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software GmbH resources.

Product Support

Support for Software GmbH products is provided to licensed customers via our Empower Portal
at https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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Release Notes

These Release Notes pertain to the Application Testing component of NaturalONE version 9.1.

What's New in Version 9.1.3

Eclipse-Independent Application Testing

It is now possible to execute a Natural unit test bed with an Ant script outside the context of a
Natural ONE/Eclipse environment. This is especially important for providing full DevOps support
if you also want to execute test cases unattended in a lean command line environment. This exten-
sion will also simplify the integration of Natural unit test processing with continuous integration
tools like Jenkins.

The functionality of writing Natural unit test cases is already covered by Natural ONE. However,
this has now been extended with a new Natural unit test Ant Script wizard, which can be used to
generate Ant based testing scripts. These scripts support several targets like checkout for checking
out a test project or unittest for executing a Natural unit test bed.

For testing purposes, you can now also execute a testing Ant script inside NaturalONE via the
Eclipse built in Run As Ant Script functionality. The results of a test run will be displayed in the
Console view.

Refer to Creating Ant Scripts to Run Unit Tests for further details.
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3 Prerequisites

When the Application Testing component of NaturalONE has been installed, you can use the test
functions supplied with Natural ONE. If this component has not yet been installed, use the Software
AG Installer to install it.

The tests are run using the EntireX RPC mechanism. While many details are hidden, you must
have some knowledge of EntireX RPC to run the tests.

To test subprograms and business services directly, and to create unit tests for subprograms and
business services, a Natural RPC server is required. The Natural Development Server cannot be
used in this context. If you are testing items in a project connected to the local Natural runtime
environment, a special connection via RPC must be made.

As a business service cannot be tested in the local Natural runtime environment without a full
local installation of Natural Business Services, the tests are simulated locally by calling the subpro-
gram directly.

| Note: Some keywords like IN, OUT or INOUT have a special meaning in EntireX and therefore
cannot be used in subprograms as group or parameter names when they are going to be
tested. Please refer to Rules for Coding Group and Parameter Names in section Software AG IDL
Editor of the EntireX documentation for a full list of these keywords.







4 Getting Started

= General Information ......

m Testing @ SubProgram DIFECHY ........eeieiiiiieei e

= Creating a Unit Test ......
= Running a Unit Test ......

= Generating an Ant Script




Getting Started

General Information

This is a brief introduction to working with the Application Testing component of NaturalONE.
It explains how to test a simple subprogram, how to save it as a unit test file, and how to generate
an Ant script from the unit test file. You can then use the Ant script, for example, with your auto-
mated nightly tests. It is assumed that you use the local RPC server which is automatically started
when you start NaturalONE.

| Note: Testing business services is not in the scope of this introduction. However, this works
similarly.

The topics below assume that you have created a Natural project which uses the local Natural
runtime. This Natural project contains a library with two objects, a subprogram and a parameter
data area (PDA).

4 @- My TestProject- = natural-runtime (1)
- = .settings
4 = Matural-Libraries
4 = MYTEST
a (EE SRC
2E PDALNSA
I8 SUBL.NSN
= -natural
n= -project

Testing is illustrated using the following simple subprogram:

DEFINE DATA PARAMETER
USING PDA1

END-DEFINE

#fresult := ffvarl + ffvar2
END

where the subprogram calls the following PDA:

DEFINE DATA PARAMETER
1 4fvarl (I4)

1 fvar2 (14)

1 ffresult (I4)
END-DEFINE

Do not forget to build your Natural project before you start testing.

10 Application Testing



Getting Started

Testing a Subprogram Directly

When you test a subprogram directly, you can analyze the parameters in a test editor. You can
change the input values, run the test, and verify the return values.

~ To test a subprogram

1 Inthe Project Explorer view, select the subprogram.

2 Invoke the context menu and choose Testing > Test Subprogram.

The test editor appears.

NT SUB1 EE = g
Test Subprogram - O -®E || ma | @

Data

#varl -> 0 Property Value
Eyar? -= 0

Fresult -= 0

Data| Connection

3 Select the entry for #varl on the left side of the test editor.

Properties are now shown on the right side of the test editor.

4  Define a value for #varl on the right side. Example:

Application Testing "



Getting Started

Wi SUB1 22

Test Subprogram

Data

#yvarl -= 3
Eyvard -= 0
Fresult -= 0

Data| Connection

= O

L RAU R R RN TR = B-RNQ)

Property Value

a Misc
IDL #varl (I4) InQut
Mame Fwvarl

4 Value
Value 3

5  Select the entry for #var2 on the left side of the test editor, and define a value on the right

side.

6 Choose the “a (Run Test) button in the local toolbar of the test editor.

The result value is now shown. Example:

12
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Getting Started

Wi SUB1 S = 5
Test Subprogram Yo v O E [ BR~|umed D@
Data
#varl -» 3 Property Value
Eyvard -= 5 4 Misc
it sl DL Zresult () InOut
Mame Zresult
4 Value
Value &

Diata | Connection

Creating a Unit Test

After defining the input and output parameters for the test, you can save this as a unit test.

~ To create a unit test

1 Make sure that the editor with your previous test is active.

2 From the File menu, choose Save As.

The New Natural Unit Test dialog appears.

Application Testing 13
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E Mew Matural Unit Test = @
Define Natural Unit Test Details -
Enter the settings for a new Natural unittest.| m

[ d

Target

Project: My TestProject
Parent suite: (default)

Testname:  SUBL
(.../Testing-Suites/SUB1.nattst)

Display generated file(s)

Matural subprogram

File name:  MyTestProject/Natural-Libraries/MYTEST/SRC/SUBL.NSN

(?:' < Back lext = [ Finish l ’ Cancel ]

The name of the subprogram is automatically provided as the name for the unit test. For now,
you need not change any information.

3 Choose the Finish button.

A folder named Testing-Suites is automatically created in the project. This folder is always
created when you create the first unit test in a project.

The unit test is stored in the new Testing-Suites folder. Unit tests for subprograms (also called
"Natural unit tests)" have the extension .nattst.

4 '[é MyTestProject-=natural-runtime (1)
- = settings
4 = Matural-Libraries
4 [ MYTEST
4 [ SRC
2E PDALNSA
SUBL.NSN
4 [= Testing-5Suites
nam oUBL.nattst
= -natural
v -project
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Getting Started

The generated unit test file is automatically shown in the unit test editor (provided that you
have not deselected the Display generated file(s) in the New Natural Unit Test dialog).

W SUB1 W7o SUB1.nattst 22 = O
Summary QE @
= Matural
Library: MYTEST

Subpregram: SUBL

+ Connection

Broker I localhost1971
Server: RPC/MATSRV2E00/CALLMAT

+ Input

#yarl -» 3
Fresult -» 8
Bvard -» 5

 Validation

+ Error

[7] Expect error

Error class: | |
Error code:

Message: [] Regex

Summary | Connection | Input | Validation

The Summary tab shows the information that will be used for the test.

You can save the test for later reuse. For example, you can use it as the basis for an Ant script.
Before you save the test, however, you have the possibility the change information on the
following tabs:
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Getting Started

® Summary
You can allow a test to pass with an expected error.

® Connection
You can define a different RPC environment for your test.

® Input
You can change the input fields that are to be sent to the server.

" Validation
You can configure the fields that are to be tested after the call to the server has been made.

Detailed information these tabs is provided later in this documentation.

4  Use the standard Eclipse functionality to save your changes. For example, press CTRL+S.

Running a Unit Test

After you have created the unit test, you can run it in order to check whether it works as expected.
~ To run a unit test

"  Choose the % button in the local toolbar of the unit test editor.
Or:

In the Project Explorer view, select the file with the extension .nattst, invoke the context menu
and choose Testing > Run Unit Test(s).

The Natural Unit Test view is automatically opened the first time you run a unit test. Example:

{3 Natural Unit Test &2 QeE@-=0
Tests Sumrmary
i SUEBL.nattst (0,051s) Test:SUBL.nattst -
RPC connection: local Matural runtime (Broker ID: localhost1971)
State: passed

Elapsed time: 0,031s

When the test was successful, the state "passed” is shown.
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Getting Started

Generating an Ant Script

You can generate XML-based Ant scripts which run your unit test files.

~ To generate an Ant script

1  In the Project Explorer view, select the project where your test was created.

2 Invoke the context menu and choose New > Other.

3 In the resulting dialog box, expand Software AG > Testing and then choose Natural Unit
Test Ant Script.

The following dialog appears.

Application Testing 17



Getting Started

£ New Natural Unit Test Ant O X

Create a Natural Unit Test Ant Script
This wizard creates a Natural Unit Test Ant Script

Project: | UnitTests2 Browse...

Matural Unit test ant file selection

Matural Unit test file: | unittest.xml Browse... Load from File @ Load Defaults

Environment

Rpc environment: Natural RPC Server "

[[] Enable fail-on-error for Ant script

Root directory: P:\oned1\NatUnit Browse...
@ < Back Next > Finish Cancel

For now, leave the provided settings as they are.

4 Choose the Finish button.

As a result the unittest.xml file is created in the Natural project folder. This file contains the
Natural Unit Test Ant script. Detailed information on the available properties is provided
later in this documentation under Creating Ant Scripts to Run Unit Tests. Usually, you run
this file outside of Eclipse via the command line.

18 Application Testing



5 Features of the Test Editors

This section describes the features of the test editors, such as navigation options and toolbar icons.
The following example shows the Test Subprogram editor. The test editors are similar for both
business services and subprograms; the main differences between the editors are that the Debug
option is not available in the Test Business Service editor and you can select the method to test
(which can change which subprogram is tested internally).

In this example, the INPUT-DATA and OUTPUT-DATA fields have been expanded:

Hoam CALC &3

Test Subprogram e G- %% - | B eh @

Data

Property Yalue
IOM -=

FFIRST-MUM -= 0.00

FSECOMD-MUM == 0.00

#SUCCESS-CRITERIA -0
= QUTPUT-DATA

FRESILT -=0.00

FTIME

#3IUCCESS -= False

[ata | Connection

Keyboard navigation is supported in all editors. In the example above, you can use keys on the
keyboard to move from one field to another in the tree view and/or navigate to the table on the

right to add or edit values.

The following table describes each of the options available on the editor toolbar:
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Features of the Test Editors

Toolbar Icon

Description

*E -

Debug

Debugs the current subprogram using the Natural ONE debug attach server and the current
values defined in the editor. For information, see Debug a Subprogram Directly.

Note: This toolbar icon is only visible in the Test Subprogram editor and when the Use debug

attach server option is selected in the Eclipse Preferences > Software AG > Natural > Debug
Attach Settings window; it is not available in the Test Business Service editor.

Run Test

Runs the current file using the values defined in the editor. Use the down arrow to display the
available environments in which to run the test and select a different environment. For example:

f‘b -
local Matural runtime
Matural RPC Server (2)
Matural RPC Server

® Matural RPC Mairframe
< Custam =

Stops the current test.

Records the test data for export to a CSV file (file extension .csv), which can then be used as
input for an external data unit test. After selecting this option, either the record function for
the test will begin or the Define External Test Details panel will be displayed to define the
external data unit test. To change details about the recording, select the down arrow. For

bh -

Configure Recording...
example:

The Define External Test Details panel is displayed. For more information, see Export Test
Data to a CSV File.

C.

Exports test data (field names and values) from the data tree in the test editor view to a new
or existing test data file (extension .tstdata) in the workspace. For information, see Export Test
Data.

I8

Imports an existing test data file in the workspace to the data tree in the test editor view by
matching field names in the imported test data file to field names in the editor tree. For
information, see Import Test Data.

Resets all data values and structures to their default values.

20
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Test a Business Service or Subprogram Directly

This section describes how to test a business service or subprogram directly. It provides an easy
way to run a business service or subprogram by analyzing the parameters, displaying them in a
test editor (tester), and allowing you to change the input values. You can then run the test and
verify the return values.

Test a Business Service Directly

This section describes how to test a business service directly. The following topics are covered:

= Test the Service

= Define Date and Time Details

= Define Connections

= Define Additional RPC Environments
= Save as a Business Service Unit Test

| Note: The subprograms used for the service must be available locally. If they are not available

locally, download them from the server.

Test the Service

~ To test a business service directly

1 Open the context menu for the business service in the Project Explorer view.

2 Select Testing.

The testing options for business services are displayed.

3  Select Test Business Service.

The business service is displayed in the editor view. For example:
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Test a Business Service or Subprogram Directly

| Caleulatar &2

Test Business Service

Data

Business service:  DEMO, Calculakor

Method: Add w

IMPUT-DATA, | Property

. CUTRLT-DATA

[ata | Connection

Walue

| Note: For information on using this editor, see Features of the Test Editors.

4  Expand the INPUT-DATA and OUTPUT-DATA nodes.

The Data tab displays the properties and values defined for each parameter used in the test.

For example:

|z Caleulator 2

Test Business Service

Data

Business service:  DEMO, Caloulakor

Method: Add w

Property
HFUMCTION -=
#FIRST-MUM -=0
#SECOMD-MUM -= 0
#SUCCESS-CRITERIA -=0
= QUTPUT-DATA,
#RESULT -> 0
#TIME
#SUCCESS - false

Data | Connection

Value

5  Select each input and output field to use in the test and define the value for the Value property.

For example:

Application Testing
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Test a Business Service or Subprogram Directly

Parameter Value

FIRST-NUM 2
SECOND-NUM (3
RESULT 5

SUCCESS true (select Value to change the value from false to true)

Optionally, you can:

Task Procedure

Define test data for another method used by the |Select the method in Method.

business service.
Note: Changing the method may change which

subprogram is tested; the parameters may also

change.

Define input parameters for the test. Expand the INPUT-DATA node and provide input
values for each property in Property and Value.

Define output parameters for the test. Expand the OUTPUT-DATA node and provide
output values for each property in Property and
Value.

Reset all data values and structures to their Select the Reset Data toolbar icon. For example:

default values.

Enter date and/or time details. See Define Date and Time Details.

Run the test in another environment. See Define Connections.

Interrupt a test that continues to run with no |Select the Stop Test toolbar icon. For example: @
response.

Export and import test data for business services|See Export/Import Test Data.
and subprograms.

Record test data and then export it to a CSV file |See Export Test Data to a CSV File.
(file extension .csv).

6 Select % to start the test.
Define Date and Time Details
When defining the value for a date and/or time field in a subprogram used by a business service,

a window is displayed to enter details about the date or time. This section describes how to access
and define details about a date or time field.

> To define details about a date or time field

1  Select Value for a date or time field in the testing editor.

For example:
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Test a Business Service or Subprogram Directly

v Caloulator 53
Test Business Service

Data

Business service:  DEMO, Calculakor

Method: Add w

[= INPUT-DATA
FFUMCTION -=
FFIRST-MUM -2 0
FSECOMD-NUM -0
#SUCCESS-CRITERIA -= 0
[= QUTPUT-DATA
FRESULT -2 0
#TIME
#SUCCESS -3 false

Drata | Conneckion

2 Selectl

J in the Value column.

Property Value
= Misc
DL FTIME (T}
Marme FTIME
= Value
Yalue

The Enter Date/Time window is displayed. For example:

7= Enter Date/Time El
[CIBlank datetime
Date: 1fz6jz01z &
Tirne: B4l PM 5

Fraction (110 second): | 1

I Ok H Cancel l

By default, the current date and time are displayed. Optionally, you can:

Task

Procedure

Blank out date and time information
when testing business services or
subprograms.

Select Blank date/time.

Change the date used for the test.

To change the month, select the up or down arrow for Date.

To change the day, select the day portion of Date and then
select the up or down arrow.

To change the year, select the year portion of Date and then
select the up or down arrow.

Application Testing
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Test a Business Service or Subprogram Directly

Task Procedure

Change the time used for the test. To change the hour, select the up or down arrow for Time.

To change the minute, select the minute portion of Time and
then select the up or down arrow.

To change the second, select the second portion of Time and
then select the up or down arrow.

Use tenths of a second to define the |Enter the number of tenths of a second in Fraction.

time used for the test.

Define Connections

This section describes the Connection tab in the editor view. This tab is used to maintain inform-
ation about the environment in which the test will run.

~ To define the connection settings

1  Select the Connection tab for the test.

For example:

[ Caleulator 22 = 0O

Connection @

Connection Settings

RPC environment: | Matural RPC Mainframe

Mote: Te maintain values for this setting, see Preferences/SoftwareAG/EntireX/RPC Environments,
[7] Custom settings

Custom connection

Set project steplibs

Data | Connection
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Test a Business Service or Subprogram Directly

This tab shows the current connection settings for the RPC environment. For this example,
the settings define a Natural RPC Mainframe environment derived directly from NaturalONE,
as well as settings indicating how the RPC server will be started.

2 Select the environment in which to run the test in RPC environment.
This value defines the name of an EntireX RPC connection configured in Eclipse.

] Note: The list of environments is defined in the Preferences window for RPC environ-

ments. For information on adding additional environments to the list, see Define Addi-
tional RPC Environments.

Or:

Select Custom settings and define the custom connection as follows:

Setting Description

Broker ID Broker identifier. Each installation of EntireX is assigned a Broker ID. This
number uniquely identifies EntireX to your network. If you do not know the
Broker ID, ask the network administrator for your organization.

Server Name of the Broker server used to logically describe a server (rather than the
name of the program that implements the server). This allows you to change
the program name without affecting the client programs that use the service.

User ID User identifier the server will use to assign the corresponding fields in the
EntireX control block when making calls using the EntireX ACI (Advanced
Communication Interface).

Password Password value the server will use to assign the corresponding fields in the
EntireX control block.

Natural logon required | Determines whether a Natural logon is required.

RPC user ID User identifier the EntireX RPC server will use to connect with the Natural
server.

RPC password Password value the EntireX RPC server will use to connect with the Natural
server.

3 Use the Set project steplibs check box to indicate whether the steplibs from the Natural project
are set in the RPC server environment. If checked, the Natural Development Server is used.
If not checked, only the RPC server environment is used, without Natural Development
Server.

| Note: Keep in mind that the Natural Development Server used by the project must al-

ways be accessible when the value is checked. The Natural Development Server is ac-
cessed to check the development mode settings for the steplib consolidation. These
steplibs are then passed to the RPC server.

4  Save the connection settings.
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Define Additional RPC Environments

You can define additional RPC environments. Once new environments have been added, they
can be selected in RPC environment on the Connection tab.

> To define additional RPC environments

1  Select Preferences on the Window menu. The Preferences window is displayed.
2 Expand the Software AG node.
3  Select EntireX > RPC Environments.
The RPC Environments settings are displayed. For example:
= Preferences |:|@@
RPC Environments v
= SoFtw.are AG Manage the RPC Environments For XMLISOAP RPC Server, Natural RPC Server and IDL Extractor For PLJT,
Ajax Developer
Business Services Table of defined RPC environments:
EE::trG:c:eration -I:I‘ame : EBroker ID Server Address
- EntireX -5. Matural RPC Mainframe IBM2 . HQ.5AG:4010 RPC/MESS3DEY/CALLNAT
NET Wrappesr _’;pN Matural RPC Server BKR13003:4010 RPCIMNESS3DEYCALLNAT
C Wrapper -_';,N Matural RPC Server (2) localhost: 1971 RPC/MATSRYZE00/CALLMAT
COBOL Wrapper T XMLISOAP RPC Server localhost: 1971 RPC/XMLSERVER/CALLNAT
Custom Wrapper i WMLISOAP RPC Server (2) localhost: 1971 RPCMLSERVER JCALLMAT
DiCOM Wrapper
Deployment Environments
EJB \Wrapper
IDL Extractor for COBOL
I0L Extractor For Matural
I0L Extractor For PLJT
I0L Extractor For W3DL
Installation
Inkeqgration Servers
Java Wrapper
Matural Wrapper
PL/I \Wrapper
W Service erer
¥ML Mapping Editar
Matural
@j Ok Cancel
4  Select Insert.
The New RPC Environment panel is displayed.
5  Select Natural RPC Server in Type.
The specification fields for this type of server are displayed. For example:
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Mew RPC Environmernt

Define a new RPC Environment,

7= RPC Environments |Z|®
im

LSRR ko &l RPC Server

Broker Parameters

Broker ID: *|

Server Address: *|

Timeout {Seconds): | a0

Entirex Authentication

P — T —

RPC Server Authentication

Exbrackor Settings

Library Mame: |

Program Mame: |

Wrapper Settings
(Cistaw () Save (3) Save local

1

Enwironment Name
(%) Default

() Other: |

Cancel

6  Provide the following details about the new environment:

Section Description

Broker parameters

Type the broker ID, server address, and default timeout values in the fields
provided.

EntireX authentication Type the user ID and password for EntireX in the fields provided.

RPC server authentication | Type the user ID and password for the RPC server in the fields provided.

Extractor settings

Type the name of the library and program from which to extract data in
the fields provided.

Wrapper settings

If the new environment is not a local environment, select Stow or Save
and provide the name of the library in which to stow or save wrapper
subprograms in Target library name.
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7

Section Description

Environment name

After entering the Broker parameters, the default name of the new
environment is displayed in this section. If you do not want to use the
default name, select Other and provide a new name.

Select Finish.

Save as a Business Service Unit Test

For more information about the settings on this panel, refer to the EntireX documentation.

After defining the input and output parameters for the test, you can save it as a business service
unit test.

> To save the test as a business service unit test

1

2

Select Save As on the File menu.

7= New Business Service Unit Test

Define Business Service Unit Test Details

Enter the settings For a new business service unit kest,

Target

- BEX

Project! | “ewProject

|[Br0wse...]

Parent suite: |

| {default) [Browse... ]

Test name: | Calculator

{.../Testing-Suites/Calculator bsrvtst)

Display generated file(s)

Business service

Service File: | MewProject /Business-Services/DEMOJCalculator. w1, 1. 1.bsry

|[Br0wse...]

Method: Add W

Finish

l [ Cancel

Provide details for the unit test.

For information, see Create a Unit Test for a Business Service.

B

The Define Business Service Unit Test Details panel is displayed. For example:

Note: You can create Ant scripts to run unit tests (file extension .bsrotst, .exttst, .nattst,

and .seqtst). For information, see Creating Ant Scripts to Run Unit Tests.
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Test a Subprogram Directly

This section describes how to test a subprogram directly. The following topics are covered:

= Access the Test Function
= Access the Debug Function
= Save as a Natural Unit Test

| Note: The subprogram must be available locally. If the subprogram is not available locally,

download it from the server.

Access the Test Function

~ To access the function to test a subprogram directly

1 Open the context menu for the subprogram in the Project Explorer view.
Or:
Open the context menu for the subprogram in the editor view.
Or:

Open the context menu for the subprogram in the Dependencies view.

2 Select Testing > Test Subprogram.

The subprogram is displayed in the editor view. For example:

s CALC b =

Test Subprogram - O~ Pa - | pued @

i ; Property Walue
+- OUTPLIT-DATA

Drata | Conneckion

This editor functions in the same way as the Test Business Service editor. The differences
between this editor and the Test Business Service editor is that this editor includes the Debug
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toolbar icon and the business service editor has an option to select the method (which can
change which subprogram is tested internally).

| Note: For information on using this editor, see Features of the Test Editors and Test a
Business Service Directly.

Access the Debug Function

This section describes how to access the Debug option from the Test Subprogram editor.

Note: To activate the Debug function, the Use debug attach server option must be selected
in the Eclipse Preferences > Software AG > Natural > Debug Attach Settings window.

~ To access the Debug function

1

Open the context menu for the subprogram in the Project Explorer view.
Or:

Open the context menu for the subprogram in the editor view.

Or:

Open the context menu for the subprogram in the Dependencies view.

Select Testing > Test Subprogram.
The subprogram is displayed in the editor view.

Select ¥ on the editor toolbar to debug the subprogram using the values currently defined
in the editor.

When a breakpoint is reached, the Debug perspective is displayed. For more information, see
Debug a Subprogram Directly.

Save as a Natural Unit Test

After defining the input and output parameters for the test, you can save it as a Natural unit test.

> To save the test as a Natural unit test

1

Select Save As on the File menu.

The Define Natural Unit Test Details panel is displayed. For example:
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7= New Natural Unit Test |._|[’E|g|
Define Natural Unit Test Details i
Enter the settings For a new Matural unit test,
e -]
Target
Praject: | MewProject | [Brnwse... ]

Parent suite: {default) |Browse...
| |
|

Test name: | CALC
(... /Testing-Suites/CALC. natkst)

Display generated fileds)

Tatural

Subprogran: | MewProjectMatural-LibrariesCS3DEMO]SRCICALC NS | [Browse... ]

@j Finish ] [ Cancel

2 Provide details for the unit test.
For information, see Create a Unit Test for a Subprogram.

J Note: You can create Ant scripts to run unit tests (file extension .bsrvtst, .exttst, .nattst,
and .seqtst). For information, see Creating Ant Scripts to Run Unit Tests.

Debug a Subprogram Directly

This section describes how to debug a subprogram via RPC using the NaturalONE debugger and
the values currently defined in the editor.

] Note: To activate the Debug context menu, the Use debug attach server option must be

selected in the Eclipse Preferences > Software AG > Natural > Debug Attach Settings
window.

~ To debug a subprogram

1 Open the context menu for the subprogram in the Project Explorer view.

2 Select Debug As > Natural Application.

The subprogram is displayed in the editor view. For example:
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i CALC &3 =5
Debug Subprogram v E B | wd D@
Data | Debug |
4 INPUT-DATA, Property Value
#FUMCTION -

HFIRST-MUM - = 0.00

H#EECOMD-MNUR - 0,00

#EUCCESS-CRITERIA, - = 0
a QUTPUT-DATA,

H#RESULT -= 0.00

HTIME

H#IUCCESS - » false

Data| Connection

This editor functions in the same way as the Test Subprogram editor.

Select the down arrow for % to select the environment in which to debug the current file
using the values defined in the editor.

For example:

fﬁ -
local Makural Funtine
Makural RPC Server (23
Makural RPC Server

& Natural RPC Mainframe
=Cuskam >

Select ¥ to debug the current file using the values defined in the editor.
When a breakpoint is reached, the Debug perspective is displayed.

@ Tip: If you receive a WAIT timeout occurred error message, try increasing the timeout

value for the selected RPC connection in the Eclipse Preferences > Software AG > En-
tireX > RPC Environments window. You can continue debugging in the Debug per-
spective when the editor receives the WAIT timeout error.

) Notes:

1. For information on using this editor, see Features of the Test Editors and Test a Subprogram
Directly.

2. For information on using a debug attach server, see Using the Debugger in Using Natural ONE.
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Export/Import Test Data

This section describes how to export and import test data for a business service and subprogram,
which allows you to populate the test data quickly without re-entering each field name. These
options are:

" Export test data (field names and values) from the test editor data tree to a new or existing test
data file (extension .tstdata) in the workspace.

| Note: The .fstdata files can be stored anywhere in the workspace.
® Import an existing test data file in the workspace to the test editor (matching field names in the
imported file to field names in the editor).
This section covers the following topics:

= Export Test Data
= |mport Test Data

Export Test Data

~ To export test data to the workspace

1 Open the context menu for the business service (or subprogram) in the Project Explorer view.

The testing options are displayed.

2 Select Test Business Service (or Test Subprogram).

The business service (or subprogram) is displayed in the editor view.

3 Select e on the editor toolbar.

The Define Details about the Test Data File window is displayed. For example:
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= Export Data |;|@@

Define Details about the Test Data File

Select a destination and enter a file name; existing files
will be owerwritten,

= Lvé MewProject-=daef.eur.ad.sag-7307 (6)

[= .settings

= .wsstack

= Business-3ervices

(= Construck

= Java
= b

(& Matural-Libraries
(== Testing-Histary

[= Testing-Suites
@. |User-Interface-Components

S calc-bus bstdata

File name: | cale-bus. kstdata |

(MewProject/calc-bus. tskdata)

[ [0] 9 l[ Cancel ]

4  Select the location in which to export the test data file.
The last exported .tstdata file is selected.

] Note: To overwrite data, select an existing file.

5 Type the name of the test data file in File name.

By default, the ".tstdata" extension is added to the file name.
6  Select OK to export the test data file.

If the test data file currently exists (as shown in the example above), an overwrite confirmation
dialog is displayed.

Example

The following example shows sample input for a business service test:
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i) Caleulatar 23 =0
Test Business Service Q- P - | B e @
Data

Business service: DEMO, Calculakor

Method: Add ~
= INPUT-DATA Froperty Walue
#FUMCTION - o Mist
#FIRST-NUM - 2 oL #SUCCESS (L)
#SECOMD-HUM - 3 Marme #SUCCESS
#SUCCESS-CRITERIA -2 0 - valus
= OUTPUT-DATA Yalue true

#RESULT -=> 5

Drata | Conneckion

After exporting the data, the following test data (.tstdata) file is created:

|Er) Caleulator |=| calc-bus.tstdata 3 =0

IINPUT—DATA HFIRIT-NUM=2
INFPUT-DATA. #3ECOHND-TUM=3
OUTPUT-DATL. $RESULT=5
OUTPUT-DATL. #3UCCESS=trus

You can modify this file using key=value pairs (for example, FIELDA=value). If the key begins
with a hash character (#), then the field name must be preceded by a \ character (for example,
\#FIELDB=value) or the field will be skipped. All other hash characters (such as CUSTOM-
ER.#NAME=value) do not require the \ character.

Tip: Using this file as an example, you can create test data files for all the functions, save

the files using appropriate names, and then change the values accordingly.

Import Test Data

~ To import test data from the workspace

1 Open the context menu for the business service (or subprogram) in the Project Explorer view.

The testing options are displayed.

2 Select Test Business Service (or Test Subprogram).

The business service (or subprogram) is displayed in the editor view.
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Select £21 on the editor toolbar.

The Import Data window is displayed. For example:

7= Import Data |;|@@

Select a test data file to import,

= ey oject->dacf eur ad sag-7307 (6) *

o4 l [ Zancel

Select the test data file to import (only projects/folders containing test data files are listed).
Select OK to import the file.

Any field in the imported test data file that does not have a matching field in the test editor
tree, or has a matching field containing an invalid value, will not be imported and will not
stop the import process. If this situation occurs, an Error log warning is displayed showing
problem fields.

Export Test Data to a CSV File

This section describes how to record the data used to test a business service or subprogram directly
and then export it to a CSV file (file extension .csv). You can then use this file as input to create an
external data unit test. For information, see Create an External Data Unit Test.

~ To record the test data and export it to a CSV file

1 Open the context menu for the business service (or subprogram) in the Project Explorer view.
The testing options are displayed.

2 Select Test Business Service (or Test Subprogram).
The business service (or subprogram) is displayed in the editor view.

3 Select % on the NaturalONE toolbar to begin recording.
The Define External Test Details panel is displayed. For example:
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7= Record Test Data

Define External Test Details

Enter details For the external (.csv) File,

Targek

Project: MewProject
Parent suite:

Jcsw file name:

File options
Delimiter: S

Sawe options: @.ﬁ.ppend (:) Owerwrite

@

- B

o

[N -]

bk

Zancel

Type the name of the external data file in .csv file name or select Browse to display a window

listing the available files for selection.

Optionally, you can use the Define External Test Details panel to:

Task

Procedure

Change the name of the project in which
to create the external data file.

Type the name of the Natural project in Project or select
Browse to display a window listing the existing projects for
selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in
which to save the external data file. If the
folder does not currently exist, it will be
created for you.

Type the name of the folder in Parent suite or select Browse
to display a window listing the available folders for selection.

By default, the external data file is stored in the
Testing-Suites folder in the current project. If you specify
a suite folder name, it becomes a subfolder in the
Testing-Suites folder and the file will be stored in that folder.

Change the delimiter character used to
separate input values in the external data
file you are generating.

Type the character in Delimiter.

Replace test data in an existing CSV file
(file extension .csv) with new data.

Select "Overwrite" in Save options.

Note: If you specify the name of an existing file in .csv file

name and the Save options is "Append" (default), the test
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Task Procedure

data is appended to existing test data in the file. If the mode
is "Overwrite", existing test data in the file will be
overwritten.

5  Select Next.

The Select Data to Record panel is displayed. For example:

7= Record Test Data

Select Data to Record

Select and configure the fields and data to sawve.

Marne Input Qutput | Index
01 INPUT-DATA [l [l
01 QUTPUT-DATA = =

lExpand All ] [Collapse all

®

6  Select Expand All

The level 1 fields are expanded to display the lower level fields. For example:
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72 Record Test Data |Z|

Select Data to Record 44
Select and configure the fields and data ko save,
[ -
Mame Input Qutput | Index

= 01 INPUT-DATA

02 2FUNCTION (A30)

02 #FIRST-HUM (M5, 2)

02 #SECOMD-NUM (M5, 2)

02 #SUCCESS-CRITERIA (NS)
= 01 OUTPUT-DATA

02 #RESULT (M11.2)

02 2TIME (T)

02 #5UCCESS (L)

OEEEEEEEO
OEEEEEEEO

Expand All l [Cnllapse all

@

] Note: To collapse the fields, select Collapse All.

7 Select Input and/or Output for each level 1 field you want to include in the recording.

Only the selected data for each field will be saved.
8 Provide index values in Index for any array fields.

9  Select Finish to begin recording.

The Recording icon changes to %= on the toolbar.

10 Define the test data in the editor view.

For example:
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[ Calculataor 53 =8
Test Business Service Qy - e ltued D@
Data

Business service: DEMO.Calculator

Methiod: Add “

= INPUT-DATA Property Yalue
#FLNCTION -= =] Misc
#FIRST-MUM -= 1 I0L #IUCCESS (L)
#SECOMND-MNUM -= 2 Mame FEUCCESS
#SUCCESS-CRITERIA -= 4 = Walue

= QUTPUT-DATA Yalue false
#RESULT -=> 4
#TIME

Data | Connection

| Note: For information on using this editor, see Features of the Test Editors and Test a

Business Service Directly.

11  Select % to run the test.

Repeat steps 10 and 11 for each test containing data you want to record.

12 Select %= to stop recording.

The generated CSV file is displayed in the Testing-Suites node in the Project Explorer view.
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= Enable for Application TESHING ... ..vvvvriiiiiee e
= Create a Unit Test for @ BUSINESS SEIVICE .......couvviiiiiiiiiie it
= Create a Unit Test for @ SUDPIOGram ........oveiiiiiii e
B Generate Default Unit TESES ...
m Create @ NEW UNit TESE SUILE ....oovveiiee e
m Create UNit TESELOG FIlES ......eiiiiiei e
B UUSE the DEPENUENCIES VIEW .....uuiuiiiiiiiiiiiiiiiiiitieae s
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This section describes how to create a Natural unit test for a business service or subprogram. This
allows you to specify a business service or subprogram to test, supply input values, and then
provide validation criteria for the output of the call (for example, you can supply two numbers
as the input values and a value for the result field as the validation criteria).

| Note: You can create Ant scripts to run unit tests (file extension .bsrotst, .exttst, .nattst, and

.seqtst). For information, see Creating Ant Scripts to Run Unit Tests.

Enable for Application Testing

When you create a new unit test, the Natural project containing the test is automatically enabled
for application testing. This will create the Testing-Suites folder in the Project Explorer view and
provide warning markers on existing unit test files that are not in the Testing-Suites folder or its
subfolders. This section describes how to manually enable a Natural project for application testing.

~ To enable a Natural project for application testing

1  Open the context menu in the Project Explorer view for the Natural project containing the
business service or subprogram you want to test.

2 Select Testing > Enable for Application Testing.

The Testing-Suites folder is added to the project. All new unit tests will be generated into
this folder (or subfolder).

Create a Unit Test for a Business Service

This section describes how to create a unit test for a business service. The following topics are
covered:

= Create the Unit Test

= Configure Input Parameters

= Define Validations

= Run the Unit Test

= QOpen a Previous Unit Test

= Run a Unit Test in Another Environment
= Test for an Expected Error
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= Test an Array Field

Create the Unit Test

> To create a unit test for a business service

1 Open the context menu for the Natural project containing the business service in the Project
Explorer view.

Or:

Open the context menu for the business service in the Project Explorer view.

2 Select Testing.

The test options for business services are displayed.

3  Select Create Unit Test.

The Define Business Service Unit Test Details panel is displayed. For example:

7= New Business Service Unit Test |:| E le

Define Business Service Unit Test Details m>

Enter the settings for a new business service unit kest,

Target
Project: | NewProject | [Browse... ]
Parent suite: | | (default) [Browse... ]

Test narme: | Calculator |

(.. Testing-Suites/Calculator bsrvist)

Display generated file(s)

Business service

Service File: | MNewProject/Business-Services/DEMO/Calculator vl 1. 1. bsry | [Browse... ]
Method: Add L

3
@) Finish ] [ Cancel ]

Using this panel, you can:
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Task

Procedure

Change the name of the project in which to
create the unit test.

Type the name of the Natural project in Project or select
Browse to display a window listing the existing projects
for selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in
which to save the unit test. If the folder
does not currently exist, it will be created
for you.

Type the name of the folder in Parent suite or select
Browse to display a window listing the available folders
for selection.

By default, the unit test is stored in the Testing-Suites
folder in the current project. If you specify a suite folder
name, it becomes a subfolder in the Testing-Suites folder
and the unit test will be stored in that folder.

Change the default name for the unit test.

Type anew name in Test name. File names are saved with
the .bsrvtst extension.

Generate default unit tests for
object-maintenance functions and/or
object-browse keys defined for business
service subprograms.

Select Generate default Construct tests. This option is
enabled when the unit test will be created for a business
service that uses Velocity or Construct-generated
object-browse or object-maintenance subprograms. For
information, see Generate Default Unit Tests.

Not display the generated files in the editor
view after generation.

Deselect Display generated file(s).

Change the location of the folder containing
the business service file.

Type or select a new folder in Service file.

Select a different method to test.

Select the method in Method.

4  Select Finish.
The unit test is displayed in the Testing-Suites folder in the Project Explorer view.
The test is also displayed in the editor view. For example:
46 Application Testing



Create a Unit Test for a Business Service or Subprogram

J

jiam Caleulator.bsrvkst &3 =0
Summary Q. @
w Matural
Project: MewProject

Business service: DEMO, Calculakor.w1.1.1
Method: Add

 Connection

Broker ID: localhost: 1971
Server: RPCIMATSAYZE00MCALLMNAT
* Input

 Yalidation

* Error

|:| Expect errar
Error class:
Error code:

Messaqe: D Regex

Summary | Conneckion | Input | Yalidation

The Summary tab displays information about the test, such as the name of the project, business
service, and method. It also displays the default connection settings. To define another con-
nection in which to run the test, see Define Connections.

| Note: You can use this tab to define an expected error, which allows a test to pass

whenever the expected error occurs. You can also use the tab to search for specified
text in an error message. For information, see Test for an Expected Error.

Select the Input tab and define which input parameters are sent to the server.

For information, see Configure Input Parameters.

Select the Validation tab and define which values must be returned for a successful test.
For information, see Define Validations.

Note: You can create Ant scripts to run business service unit tests (file extension .bsrvtst).
For information, see Creating Ant Scripts to Run Unit Tests.
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Configure Input Parameters

> To configure the input parameters sent to the server

1  Select the Input tab in the unit test editor.

For example:

ik MCUSTH_GET_1.nakkst 53

Input

Configure the input fields o be sent ko the server,

Field Mame Index

CSTOMER., CUSTOMER-MUMBER.
CDACETZ #FUMCTION

Surmmary | Connection | Input | Yalidation

2 Select Add.

=8
Q=@

11111
GET

Add Array...

The Configure Input Field window is displayed. For example:

’ Configure Input Field

E= N PUT-DATA, ZFLINCTION
Inde:x:

Yalue

Ok H Cancel ]

The list of available controls in Field name is based on the data type of the input field. If you
selected a logical field, for example, two option buttons are displayed to select "true" or "false".
If the field is an array, you can type the index for the array in Index.

3  Select the name of the input field in Field name.

4  Type the field value in Value.
5  Select OK.

The new field is added to the list of fields on the Input tab.
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Optionally, you can use the Input tab to:

Task Procedure

Edit an input field. See Edit an Input Field.

Remove one or more input fields.  |Select one or more input fields in Field Name using standard
selection techniques and select Delete. The field(s) is removed
from the list of fields and will not be sent to the server.

Duplicate an input field. See Duplicate an Input Field.

Add multiple elements to an array |See Add Multiple Elements for an Array Field. This option is
field. enabled when the PDA contains array fields.

Edit an Input Field

~ To edit an input field

1 Select the input field in Field Name on the Input tab.
2 Select Edit.

The Configure Input Field window is displayed to edit the field information.
3  Select OK to save the changes.

Or:

Select the input field in Field Name and edit the Value and/or Index values within the table.

Duplicate an Input Field

> To duplicate an input field

1 Select the input field in Field Name on the Input tab.
2 Select Duplicate.

The Configure Input Field window is displayed to edit the field information.
3  Select OK to save the duplicate field.
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Add Multiple Elements for an Array Field

This section describes how to define a range of values for an array field.

| Note: The Add Array option does not support byte array and date/time fields.

~ To add multiple elements to an array field at the same time

1  Select Add Array.

The Define Array Element Details window is displayed. For example:

'P Add Array Elements

Define Array Element Details

Enter elements of the array, one entry per line,

DN /D). 1/ AREHOUSE-PROVINCE (AZD)

Walue{s)

®

2 Type each element of the array in Value(s), one entry per line.

3 Select OK to save the array field.
Define Validations

This section describes how to create unit test validations for Natural errors and data entry based
on validator types (i.e., not restricted to characters in the data type).

> To define validations

1 Select the Validation tab in the business service unit test editor.

For example:
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jim MCUSTM_GET_1.nattst 53

Validation

Zonfigure fields to be tested after the call to the server is made,

Field Marme

Index

Walue

‘alidator

MSGE-INFO. ##M5G
M3G-INFO. # #RETURN-CODE

Comparisoniali,..

Stringwalidator

=0
&EO®

Add Array, .

Summary | Conneckion | Input | Yalidation

2 Select Add.

The Configure Field Validation window is displayed. For example:

'P Configure Field Yalidation

Field name: | INPUT-DATA, #FUNCTION

Inde:x: |

‘alidator: |String'u'alidatnr

Yalue

Walue: |

OF

] [ Cancel

l

The list of available controls in Field name is based on the data type of the input field. If you
select a logical field, for example, two option buttons are displayed to select "true" or "false".

If the field is an array, you can type the index for the array in Index.

3 Select the name of the input field in Field name.

4  Select the type of validator to use for the input field in Validator.

The type of validator to use depends on the type of data in the field. The available validators

are:

BooleanValidator

ByteValidator

® ComparisonValidator (displays a combo box with the options: ">", "

DateValidator

<v| n_n lv<=n H>=ll)

7 7 7
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® DecimalValidator

* IntegerValidator

" RegexValidator (creates regular expressions to validate the contents of a field)

= StringValidator

® TimeValidator

5  Select OK.

The new field is added to the list of fields on the Validation tab.

Optionally, you can use the Validation tab to:

Task

Procedure

Edit a field validation.

See Edit a Field Validation.

Remove one or more field validations.

Select one or more fields in Field Name using standard
selection techniques and select Delete. The field validation(s)
is removed.

Duplicate a field validation.

See Duplicate a Field Validation.

Add multiple validations for an array
field.

See Add Multiple Validations for an Array Field. This option
is enabled when the PDA contains array fields.

Edit a Field Validation

> To edit a field validation

1  Select the field in Field Name on the Validation tab.

2  Select Edit.

The Configure Field Validation window is displayed to edit the field information.

3 Select OK to save the changes.

Or:

Select the input field in Field Name and edit the Value and/or Index values within the table.

52
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Duplicate a Field Validation

~ To duplicate a field validation

1  Select the input field in Field Name on the Input tab.

2 Select Duplicate.

The Configure Field Validation window is displayed to edit the information.

3 Select OK to save the duplicate field validation.

Add Multiple Validations for an Array Field

This section describes how to define validations for an array field.

] Note: The Add Array option does not support byte array and date/time fields.

~ To add multiple validations to an array field

1  Select Add Array.

The Define Array Element Details window is displayed. For example:

'P Add Array Elements

Define Array Element Details

Enter elements of the array, one entry per line,

- B

Field name: Fh'l."l."HEil."."'."F'.F!.EHIZZZI|_|'E-E-F'F!.IZZZI'-.-'II"-IIZZE (420}

Walidator; | Stringwalidator w |
Walue{s)
"
©

2 Type each element of the array in Value(s), one entry per line.

3  Select OK to save the array field.
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Run the Unit Test

This section describes how to run one or more unit tests. It includes information about the Natural
Unit Test window.

] Note: You can create Ant scripts to run unit tests (file extension .bsrvtst, .exttst, .nattst, and
.seqtst). For information, see Creating Ant Scripts to Run Unit Tests.

> To run one or more unit tests

1 Open the context menu for one of the following items in the Project Explorer view.

" A project containing the Testing-Suites folder.
® The Testing-Suites folder or a subfolder within the folder.

® One or more unit test files (file extension .nattst or .bsrvtst), regardless of where they exist.
Use standard selection techniques to open the unit test(s). Any test files stored outside of
the Testing-Suites folder display a warning marker in the Project Explorer view and an
entry in the Problems view indicating that they are not in the proper place.

2 Select Testing > Run Unit Test(s).

| Note: You can also use the context menu to change the environment in which a test is

run. For information, see Run a Unit Test in Another Environment.

The selected tests are displayed in the editor view and the results of the test are displayed in
the Natural Unit Test view. For example:

E Properties | g Matural Unit Test 53 % ich gﬂ:_ﬂﬂ -~ 0O

Summary

TestCALC nakkst

RPC connection: Matural RPC Mainframe (Broker ID: IBM2,HG,SAG:4010)
State: passed

Elapsed time: 0.484s

| Note: If the test did not pass, a red circle () is displayed on the test icon in the Tests

section and State: failed is displayed in the Summary section.

The following table describes each of the options available on the toolbar for the Natural Unit
Test view:
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Toolbar Icon | Description

Q, Runs the current unit test using the values defined in the editor view.

Tip: You can also select % in the editor view to run the test.

i Selects the current unit test in the editor view.

= Opens the business service or Natural subprogram used for the current unit test in the
editor view.

&- Displays the test history for the last 10 unit tests that were run during the current Eclipse
session and allows you to select a previous test and load it into the editor. For information,
see Open a Previous Unit Test.

The Tests section in the Natural Unit Test view displays the name of each unit tests that have
been run. You can use the context menu for a unit test in the Tests section to select more op-
tions. For example:

= Properties EE Matural Urit Test &2 % RB gﬂ:_ﬂﬂ L'=|B -—0
Tests Summary
|E£.'J Calculabor . bisrvksk (0, Sk Tactu“aleulabor hepybst
q, Run... Matural RPC Mainframe (Broker ID: IBM2.HD.SAG:4010)
iz Open unit test Calculator bsrtst Fas

gﬂ:_iaﬁ Open Calculator.v1,1.1 . bsry

< >
Using this menu, you can:
Task Procedure
Run the unit test. Select Run.

Open the unit test file in the editor|Select Open unit test UnitTestName. The following file types are
view. available for selection:

" business service (file extension .bsrvtst)

" external data (file extension .exttst)

® Natural unit test (file extension .nattst)

= sequence (file extension .seqtst)

Open the associated business Select Open BusinessServiceName.bsrv or Open
service or Natural subprogram file|NaturalSubprogramName.NSN. The following file types are
in the editor view. available for selection:

® business service (file extension .bsrv)

= external data (file extension .NSN)

Note: This option is not available for external data or sequence unit

tests.
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The Summary section in the Natural Unit Test view displays:

Name of the test

Name of the RPC connection

Whether the test passed or failed

Length of time in seconds that the unit test executed before completing

To see the results of another test, select the test in the Tests section and the results are displayed
in the Summary section. For example:

] Properties | U Makural Unit Test 52 B RO
Tests Surnmary

[ CALC.nattst (0,375
(7]

)

Test:Calculabor, bsrvbst

RPC connection: Matural RPC Mainframe (Broker 1D IBMZ,HOQ.SAG:4010)
State: passed

Elapsed time: 2.062s

Calculator.bsrvt

Open a Previous Unit Test

~ To open a previous unit test

1 Select @ - on the toolbar in the Natural Unit Test view.

A list of the last 10 tests run during the current Eclipse session is displayed with a message
indicating the success of each test. For example:

] Properties | Y Matural Unit Test 52 ‘:{3 i B-— 0O
Tests Surmmarsy |§£.'J Calc.exttst {passed)

Test: Calc,exttst [ Cale. exttst (Failed)

State: passed [ MCUSTHN_MEXT nattst {passed)

Elapsed time: 1.125s
|§£.j MCUSTM_STORE. nattst {passed)

|§% MCUSTM_EXISTS. nattst. .. {passed)
|§3J Customer_GET_1.bsrvtst (Failed)
|§£.j Calculator bsrvtst {passed)

|53J Customer_E=ISTS.bsrvtst, .. (Failed)
|g£fj CALC.natkst, .. (passed)

|§£.j MCUSTM_EXISTS. nattst. .. {passed)

In this example, seven tests passed and three tests failed.

2 Select the test you want to open.

The test is displayed in the Natural Unit Test view. For example:
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] Properties | [ Matural Unit Test &3 i@ BT~ O
Tests Surnrnaryy

|g'::fj Test: Calculator bsrvtsk
RPC connection: Matural RPC Mainframe (Broker ID: IBMZ2 . HQ. SAG:4010)
State: passed
Elapsed time: 0.578s

Calculator, bsrvtst (0

3 Open the context menu for the test.

4 Select the unit test file in Open unit test UnitTestName.nnntst.
The following unit test file types are available:

® business service (file extension .bsrvtst)
" external data (file extension .exttst)
® Natural unit test (file extension .nattst)

" sequence (file extension .seqtst)

Run a Unit Test in Another Environment

You can run any unit test in another environment.

~> To run a unit test in another environment

1 Open the context menu for one of the following items in the Project Explorer view.

" A project containing the Testing-Suites folder.
® The Testing-Suites folder or a subfolder within the folder.

® One or more unit test files (file extension .bsrvtst, .exttst, .nattst, and .seqtst), regardless of
where they exist.

2 Select Testing > Run Unit Test(s) using Environment.
3  Select the environment in which you want to run the test.
The results of the test are displayed in the Natural Unit Test view.

] Note: The list of environments is defined in the Preferences window for RPC environ-

ments. For information on adding additional environments to the list, see Define Addi-
tional RPC Environments.
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Test for an Expected Error

To allow a test to pass with an expected error, define information about the error in the Error
section of the Summary tab. For example:

- Error
[C]Expect errar
Error class:
Error code:

Message: [regex

Summary | Input | Yalidation | Connection

This will allow a test to fail only if it encounters an unexpected error.

~ To test for an expected error

1  Select Expect error.

2 Type the error class in Error class.

For Natural errors, the error class is 1014.

3 Type the error code in Error code.

You can also use the Error section to search the message text for a specific string.

~ To search the message text for a specified string

1 Type the string in Message.
2 Select Regex.

If you specify ".* division by zero.*", for example, Regex will search for "division by zero'
anywhere in the error message.

Test an Array Field

You can expand or reduce an X-array using the Resize Array property. For example:
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=~ E1-50ME-PARMS
UMI-FIELD -=
ROWS]

Property
= Array

Preserve data

Resize Array
= Misc
Mame

Value

true
20

ROWS]

For some arrays, all values are displayed. For example:

E1-SOME-PARMS
ROWS(]

Property
= Array

Value

Preserve data frue

Resize Array
= Misc
IDL
Mame
= value
Value (1)
Value (2}
Value (3}
Value (4)
Value (5)
Value (&)
Value (7}
Value (&)
Value [2)
Value {10}

10

ROWS {A10/V10) InOut
ROWS

Create a Unit Test for a Subprogram

~ To create a unit test for a subprogram

1 Open the context menu for the Natural project containing the subprogram in the Project Ex-

plorer view.

Or:

Open the context menu for the subprogram in the Project Explorer view.

2 Select Testing.

The test options for subprograms are displayed.

3  Select Create Unit Test.

The Define Natural Unit Test Details panel is displayed. For example:
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7= Mew Natural Unit Test

Define Natural Unit Test Details

Enter the settings For a new Matural unit test,

Target

- O

-] =

[N -

Praject: | MewProject

| [Brnwse...]

Parent suite: |

| (default)

Test name: | CALC

(... /Testing-Suites/CALC. natkst)

Display generated fileds)

Tatural

Subprogran: | MewProjectMatural-LibrariesCS3DEMO]SRCICALC NS

| [Brnwse...]

Finish ] [ Cancel

Using this panel, you can:

Task

Procedure

Change the name of the project in which
to create the unit test.

Type the name of the Natural project in Project or select
Browse to display a window listing the existing projects
for selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in
which to save the unit test. If the folder
does not currently exist, it will be created
for you.

Type the name of the folder in Parent suite or select Browse
to display a window listing the available folders for
selection.

By default, the unit test is stored in the Testing-Suites
folder in the current project. If you specify a suite folder
name, it becomes a subfolder in the Testing-Suites folder
and the unit test will be stored in that folder.

Change the default name for the unit test.

Type a new name in Test name. File names are saved with
the .bsrvtst extension.

Generate default unit tests for
object-maintenance functions and/or
object-browse keys defined for Natural
subprograms.

Select Generate default Construct tests. This option is
enabled when the unit test will be created for Velocity or
Construct-generated object-browse or object-maintenance
subprograms. For information, see Generate Default Unit
Tests.

Not display the generated files in the editor

view after generation.

Deselect Display generated file(s).
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Task Procedure
Change the location of the folder Type or select a new folder in Subprogram.
containing the subprogram file.

Select Finish.

The unit test is displayed in the Testing-Suites folder in the Project Explorer view.

The test is also displayed in the editor view. For example:

1@ CALC. nakkst g
Summary Gy @

+ Matural

Project: MewPraject
Library: DEMOTEST
Subprogram:  CALC

+ Connection

Broker ID:  IBMZ2.HQ.5AG:4010
Server: RPCIMBSS3IDEVCALLNAT

* Input
+ Yalidation

* Error

[JExpect error

Error class:

Error code:

Message: [regex

Surmary | Connection | Input | Yalidation

The Summary tab displays information about the test, such as the name of the project, library,
and subprogram. It also displays the default connection settings. To define another connection
in which to run the test, see Define Connections.

| Note: You can use this tab to define an expected error, which allows a test to pass when

the expected error occurs. You can also use the tab to search for specified text in an
error message. For information, see Test for an Expected Error.

5  Select the Input tab and define which input parameters are sent to the server.
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For information, see Configure Input Parameters.

6  Select the Validation tab and define which values must be returned for a successful test.

For information, see Define Validations.

7  Run the test.
For information, see Run the Unit Test.

| Note: You can create Ant scripts to run Natural unit tests (file extension .nattst). For inform-

ation, see Creating Ant Scripts to Run Unit Tests.

Generate Default Unit Tests

This section describes how to generate default unit tests for browse keys and maintenance functions
(for example, GET, NEXT, etc.) defined for Velocity or Construct-generated object-browse or object-
maintenance subprograms. If a business service uses both object-browse and object-maintenance
subprograms, default tests can be generated for both the browse keys and the maintenance func-
tions.

This section covers the following topics:

= Generate Tests for a Business Service
= (Generate Tests for a Natural Subprogram

Generate Tests for a Business Service

~ To generate default unit tests for a business service

1  Select Testing > Create Unit Test from the context menu for the business service in the Project
Explorer view.

The Define Business Service Unit Test Details panel is displayed.

2 Select Generate default Construct tests.

For example:
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7= Mew Business Service Unit Test |:|®

Define Business Service Unit Test Details m

Enter the settings for a new business service unit kest,

- -

Target
Project: | :\IewProject | [Browse... ]
Parent suite: | | (default) [Browse... ]

Test name: | Zuskamer |

(.. fTesting-Suites/Customer bsrvst)
Generate default Construct kests
Display generated file(s)

Eusiness service

Service file: | MewProject JBusiness-Services/DEMO/Custorner.wi, 1.1, bsry | [Browse... ]
Method: | BROWSE ~|
@ Mext = ] [ Finish ] [ Cancel

] Note: This option is only available when the business service uses one or more subpro-

grams that were generated by an Object-Browse and/or Object-Maint wizard (either
Velocity-based or Construct).

3  Select Next.

The Define Parameters for the Default Maintenance Tests panel is displayed. For example:
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V= Mew Business Service Unit Test

Define Parameters for the Default Maintenance Tests [
Select and configure parameters for the generated kests,
[ -
Parent suite Folder: ... Testing-Suites
Select which tests to generate:
Generake Function Unik Test Marne Populate Key
EXISTS Custamer_EXISTS_1
FORMER Customer_FORMER_1 [l
GET Custamer_GET_1
INITIALIZE Customer_INITIALIZE 1 [l
MEXT Custamer_MEXT 1 [l
STORE Customer _STORE_1
[Generate Al ] [Generate Mone
Praovide walues For key Fields:
Field Mame Yalue
CUSTOMER., CIUSTOMER-MUMBER (MS) 0
Moke: Some bests may Fail because the specified key field value{s) may nok exist,
W
@) [ < Back ” Mek = l I Finish ] [ Cancel l

- B

] Note: If the business service does not use any object-maintenance subprograms, the

Define Parameters for the Default Browse Tests is displayed.

This panel displays the functions defined for all object-maintenance subprograms used by
the business service, as well as the key fields. Using this panel, you can:

Task

Procedure

Limit the generation of one or more
default tests.

Deselect Generate for the unit test(s) you do not want to
have generated. To generate unit tests for all functions, select
Generate All.

Limit the generation of all default tests.

Select Generate None.

Change the default population of key
fields.

Select or deselect Populate Key for the default unit test(s).
When selected, the test for the corresponding function will
populate the key field with the value specified in Value.

Provide a value for a key field.

Select Value for the key field and type the value. For
example, you can provide a customer number for the
Customer number field.

Enter details for a date/time field (when
defining details for a date or time field).

See Define Date and Time Details.
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Default tests can be created for each function defined for the subprogram that does not require
an existing record to be on hold. These functions are:

® STORE

* GET

NEXT

FORMER

EXISTS

INITIALIZE

| Note: As the DELETE and UPDATE functions require an existing record to be held,
default tests are not generated for these functions.

4  Specify a key value in Value for each function.

The tests are designed with the assumption that this value exists (i.e., the test will pass when
the value exists). The following assumptions are also made:

Function |Assumption

STORE |Assumes the specified key value exists and expects an error from the subprogram saying
the value already exists.

FORMER | Assumes a key value is not entered and expects a message from the subprogram saying
the beginning of file condition has occurred.

NEXT  |Assumes that the end of file condition has not occurred and expects a message from the
subprogram saying the next record was retrieved successfully.

The key components are those listed in the object PDA for the object-maintenance subprogram
as elementary fields under STRUCTURE. For example, MCUSTN, an object-maintenance
subprogram used by the Customer business service (located in the SYSBIZDE library), uses
the MCUSTA PDA:

1 MCUSTA-1ID N 5 /* Object identifier

R 1 MCUSTA-ID /* REDEF. BEGIN : MCUSTA-I
2 STRUCTURE /* To allow MOVE BY NAME
3 CUSTOMER-NUMBER N 5

In this example, CUSTOMER-NUMBER will be used as the key.
5  Select Finish.

Unit tests are created for all available browse keys and any object-maintenance subprogram
functions selected on the Define Parameters for the Default Maintenance Tests panel.

Or:
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Select Next.

The Define Parameters for the Default Browse Tests panel is displayed. For example:

7= New Business Service Unit Test |;|@

Define Parameters for the Default Browse Tests m

Select and configure parameters For the generated tests,

[N -]

Parent suite Folder: ... /Testing-Suites

Generate Key Unit Test Mame
MAME Customer-ByMAME
MAME-BACKWARDS Custaorner-ByMAME-BACKWARDS
MAME-WAREHOLUSE Custarner-ByMAME-WAREHOLUSE
CUSTOMER-NUMBER Custarner-ByCUSTOMER-NUMBER
CUSTOMER-NUMBER-BACK WARDS Custarner-ByCUSTOMER-NUMBER -BACKWARDS

[Generate all ] [Generate Mone

'@:‘ Finish l[ Cancel ]

] Note: If the business service does not use any object-browse subprograms, Next is not

available on the Define Parameters for the Default Maintenance Tests panel.

This panel displays the key fields defined for all object-browse subprograms used by the
business service. Using this panel, you can:

Task Procedure

Limit the generation of one or more default|Deselect Generate for the unit test(s) you do not want to

tests. have generated. To generate unit tests for all keys, select
Generate All
Change the name of a default unit test.  |Type the new name for the unit test on the corresponding

line in Unit Test Name.

Limit the generation of all default tests.  |Select Generate None.

Default tests can be created for each browse key defined for the subprogram. These tests include
default validations for items like rows returned and error codes. For a HISTOGRAM key, key
value totals can be verified.

6  Select Finish.
The default unit tests are displayed in the Testing-Suites folder in the Project Explorer view.

The tests are also displayed in the editor view. For example:
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W Customer-ByNAME-BACK g Customer-ByhAME-WARE N Cuskomer-BywCUSTOMER- W Customer-By CUSTOMER- oy i =0
Summary Qy @
~ Natural
Project: MewProject
Business service: DEMO, Customer.wl.1.1
Method: BROWSE

* Connection
Broker IO localhosk: 1971
Server: RPC/MATSRYZE00/CALLNAT

* Input

CDERPDA.SORT-KEY - CUSTOMER-NUMBER-BACKWARDS
CDERPDA.ROWS-REQUESTED -= 20

+ Yalidation

COERPDA. ACTUAL-ROWS-RETURMED -= 0 {Comparisonyalidator)
MSG-INFO, ##RETURN-CODE -> {Comparisonialidator)
ACUSTR.PREW-REC -=> (Comparisony'alidator)

- Error

CJExpect error

Error class:

Error code:

Message: [CIrege:x

Summary | Conneckion | Input | Yalidation

Default input values and validations are created for each unit test. You can change the default

values by selecting the appropriate tab. For example, select the Input tab to change the input
values generated for the test:

1 Customer-ByCUSTOMER-MUMBER-BACKMWAARDS, bisrytst &3 =g
Input Q, @
Configure the input fields to be sent ko the server,
Field Mame Index | Walue
(CODBRPDA. SORT-KEY CUSTOMER-MU. .. ¢
CDBRPDA, ROYWS-REQUESTED 20

Surmary | Connection | Input | Walidation

. Note: For more information, see Configure Input Parameters.

Select the Validation tab to change the validations generated for the test. For example:
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1igm Customer-ByCUSTOMER-MUMBER.-B&CK WARDS, bisryvtst £5 =g
Validation QE @
Configure fields to be tested after the call bo the server is made.
Field Mame Index = Value Yalidatar
#_DBRPDA, ACTUAL-ROMWS-RETIURMED u] Comparisonvali,..
M3G-INFO, # #RETURN-CODE Camparisonvali,..
ACUSTP.PREY-RED) Comparisoniali, ..

Add Array...

Summaty | Connection | Input | Yalidation

) Notes:

1. For more information, see Define Validations.

2. You can create Ant scripts to run unit tests (file extension .bsrvtst, .exttst, .nattst, and .seqtst).
For information, see Creating Ant Scripts to Run Unit Tests.

Generate Tests for a Natural Subprogram

~ To generate default unit tests for a Natural subprogram

1  Select Testing > Create Unit Test from the context menu for the subprogram in the Project
Explorer view.

The Define Natural Unit Test Details panel is displayed.

2 Select Generate default Construct tests.

For example:
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7= Mew Natural Unit Test : @
-]

Define Natural Unit Test Details =
Enter the settings Far a new Matural unik test,
e
Targek
Project: | MewProject | [Brnwse... ]
Parent suite: | | {default) [Brnwse... ]
Test name: | |
(... /Testing-Suites)
Generate default Construck tesks
Display generated Filels)
Matural
Subprogram: | MewProject/Matural-Libr aries/DEMCTESTISRCIMCUS T, M3M | [Brnwse... ]
® [ ek = ] I Firish ] [ Zancel ]

] Note: This option is only available when the subprogram was generated by an Object-
Browse or Object-Maint wizard (either Velocity-based or Construct).
3  Select Next.

If the subprogram was generated by an Object-Maint wizard, the Define Parameters for the
Default Maintenance Tests panel is displayed. For example:
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7= New Matural Unit Test |-_||'E|E|
Define Parameters for the Default Maintenance Tests e~
Select and configure parameters For the generated kests,
e -]

Parent suite Folder: ...JTesting-Suites
Select which tests bo generate:

Generate Function Unit Test Mame Populate Key
STORE MCUSTH_STORE_Z
GET MCUSTH_GET_2
MEXT MCUSTH_MEXT 2 |
FORMER, MCUSTH_FORMER_Z |
EXISTS MCUSTH_EXISTS_Z
IMITIALIZE MCUSTN_INITIALIZE_Z ]

[Generate Al ] [Generete Maone

Provide walues for key fields:

Field Name Walue
CIUSTOMER., CUSTOMER-MUMEBER (WS ]

Maoke: Some kests may Fail because the specified key Field valug(s) may nok exist,

@j [ Finish ] [ Cancel

This panel is similar to the Define Parameters for the Default Maintenance Tests panel for
a business service unit test. For a description of this panel, see Generate Tests for a Business
Service.

Or:

If the subprogram was generated by an Object-Browse wizard, the Define Parameters for
the Default Browse Tests is displayed. For example:
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7= Mew Natural Unit Test

Define Parameters for the Default Browse Tests

Select and configure parameters For the generated tests,

Parent suite Folder: ... /Testing-Suites

Generate Key Unit Test Mame
MAME ACISTH-ByMAME
MAME-BACKWARDS ACSTH-ByMAME-BACKWARDS
MAME-WAREHOLUSE ACISTH-ByMAME-WAREHOLUSE
CUSTOMER-NUMBER ACSTN-By CUSTOMER-NUMBER
CUSTOMER-NUMBER-BACK WARDS ACSTH-By CUSTOMER-NUMBER -BACK WARDS

[Generate all ] [Generate Mone

@j [ Finish ][ Zancel ]

This panel is similar to the Define Parameters for the Default Browse Tests panel for a
business service unit test. For a description of this panel, see Generate Tests for a Business
Service.

4  Select Finish.
The default unit tests are displayed in the Testing-Suites folder in the Project Explorer view.

The tests are also displayed in the editor view. For example:
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i ACUSTH-ByMAME-WAREHO High ACUSTH-ByCUSTOMER-MU
Summary

« Natural

Prajeck: MewProject

Library: DEMOTEST
Subprogram:  ACUSTH

+ Connection

Broker ID:  IBMZ2.HQ.SAG:4010
SErVEer! RPCIMBSSIDEY CALLMAT
 Input

CDBRPDA, SORT-KEY - CUSTOMER-NUMEBER.-BACKWARDS
CDBRPDA, ROWS-REQUESTED - 20

« Yalidation

CDBRPDA, ACTUAL-ROWS-RETURMED - = O (Comparisontalidatar)
MSiE-INFC, # #RETURN-CODE - = {Comparisonyalidator)
ACJSTP.PREY-REQ -= (Comparisonvalidator)

* Error

|:| Expect errar
Error class:
Error code:

Message:

Summary | Conneckion | Input | Yalidation

Create a New Unit Test Suite

ik ACUSTH-ByCUSTOMER-KL 52

=8
&= ®
DRegex

This editor is similar to the editor for a business service unit test. For a description of the ed-
itor, see Generate Tests for a Business Service.

This section describes how to create a new unit test suite to organize and store your Natural and
business service unit tests (file extension .bsrvtst, .exttst, .nattst, and .seqtst). The tests are generated

into the Testing-Suites folder or subfolder within a specified Natural project.

Note: Ant scripts for Natural unit tests may contain unit test files existing outside of the

Testing-Suites folder or subfolder.

~ To create a new unit test suite

Or:

Or:

Select Testing-Suites > Create Test Suite in the Project Explorer view.

Select Testing > Create Test Suite for a project in the Project Explorer view.
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Select Testing-Suites > SubfolderName > Create Test Suite in the Project Explorer view.

The Define Test Suite Details panel is displayed. For example:

T= New Test Suite

Define Test Suite Details

Enter the target settings For a new tesk suite,

Targek

Project: ewProjeck
Parent suite: (default)

Suite narme:

oy

Using this panel, you can:

Task Procedure
Change the name of the project in Type the name of the Natural project in Project or select Browse
which to create the test suite. to display a window listing the existing projects for selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) | Type the name of the folder in Parent suite or select Browse
in which to save the unit test. If the  |to display a window listing the available folders for selection.
folder does not currently exist, it will

be created for you. By default, the unit test is stored in the Testing-Suites folder

in the current project. If you specify a suite folder name, it
becomes a subfolder in the Testing-Suites folder and the unit
test will be stored in that folder.

2 Type the name of the test suite in Suite name.

3  Select Finish.

The test suite is generated into the Testing-Suites folder or subfolder.
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Create Unit Test Log Files

This section describes how to create unit test log files and then use the log files to create summary
reports. Log files can be created for any subprogram and business service unit test executed
within a NaturalONE project.

Create Unit Test Log Files
A unit test history log file can be created to save the results of a unit test whenever it is executed
(for example, the test name, test status, date/time completed, error messages, etc.). To create these

files, you must select the option in the Preferences window for Testing. For information, see Set
Logging Preferences for Unit Tests.

Use the Dependencies View

When a generated module is open in the editor view, the Dependencies view displays dependencies
between business service and Natural unit tests and the business services and Natural subprograms
they execute. This section describes the nodes contributed to the view for these resources. The
following topics are covered:

= Business Service Unit Test Resources
= Natural Subprogram Unit Test Resources

] Notes:

1. Select 1% to sort the resources alphabetically.
2. Select 4 to export a textual representation of the visible nodes in the view to a file.

3. When a supporting resource cannot be found locally using the project steplib chain and project
references, "<Unknown>" is displayed with the name of the resource. If the unknown module(s)
is not shipped with the Construct runtime project, either manually download it from the server
or create it locally. If the module(s) is shipped with the Construct runtime project, add the
project. For information, see NaturalONE's Code Generation documentation.

4. For more information about the Dependencies view, see the description of the source editor
in Using Natural ONE.
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Business Service Unit Test Resources

When a business service unit test is open in the editor view, the root node displays the name of

the business service unit test. In caller mode (&), no child nodes are displayed because no other
Dependencies view objects depend on this business service unit test file. For example:

?—E Dependencies &2 = %m|%l%ed T 8

= [y DEMO:Calculator.vi.1.1
Hm Calculator

In callee mode (=)}, the child nodes display the name of the business service that the unit test ex-
ecutes, along with the names of the supporting business service resources and the names of the
libraries and projects in which they are located. For example:

?—E Dependencies i3 = S|l ed T O

= [y DEMO:Caloulator. vl 1.1
=4 DEMO
= DEMOTEST:CALCY
i DEMOTEST:CALC

Natural Subprogram Unit Test Resources

When a Natural subprogram unit test is open in the editor view, the root node displays the name
of the unit test. In caller mode ("), no child nodes are displayed because no other Dependencies

view objects depend on a unit test file; in callee mode ( *m ), the child node displays the name of
the Natural subprogram that the unit test executes, along with the names of the supporting Nat-
ural resources and the names of the libraries and projects in which they are located. For example:

?—E Dependencies &2 o | e | %% ed T 0

=y ACUSTM
| DEMOTEST:ACUSTN
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= Create the Unit Test

= Configure Column Mappings and Sample Data .............oooiiiiiiiiiiiee e
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This section describes how to create a unit test that accepts input and/or validations from a CSV
file (file extension .csv). You can create a unit test once and then provide a data file containing
different input or validations to run iterations of the test. The wizard creates a unit test file that

accepts data from the CSV file.

] Note: Similar to other unit tests, external data unit tests can be run from the unit test Ant

script. For information, see Creating Ant Scripts to Run Unit Tests.

Create the Unit Test

> To create an external data unit test

1  Select Testing > Create External Data Unit Test for a project in the Project Explorer view.

Or:

Select Testing-Suites > Create External Data Unit Test in the Project Explorer view.

Or:

Select Testing-Suites> SubfolderName > Create External Data Unit Test in the Project Explorer

view.

The Define External Data Unit Test Details panel is displayed. For example:

= New: External Data Unit Test

Define External Data Unit Test Details

Enter the settings For a new external data unit test,

Target
Praject! ewProject
Parent suite: | CalculatorTests

Test name:

Display generated file(s)
Source unit besk details
() Create new test
(%) Use existing test
Source data file (C3W) details
() Create new file
(3) Use existing File

@)

Py

Cancel
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Using this panel, you can:

Task Procedure

Change the name of the project in which | Type the name of the Natural project in Project or select
to create the external data unit test. Browse to display a window listing the existing projects for
selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in | Type the name of the folder in Parent suite or select Browse
which to save the external data unit test. | to display a window listing the available folders for selection.

If the folder does not currently exist, it
will be created for you. By default, the unit test is stored in the Testing-Suites folder

in the current project. If you specify a suite folder name, it
becomes a subfolder in the Testing-Suites folder and the unit
test will be stored in that folder.

Type the name of the external data unit test in Test name.

Select an existing business service or Natural unit test in the Source unit test details section.

The selected unit test will be executed for each row in the data file. To display the available
unit test files for selection, select Browse for Use existing test. Optionally you can create a
new business service or Natural unit test. For information, see Create a New Unit Test.

Select an existing data file in the Source data file (CSV) details section.

To display the available CSV data files for selection, select Browse for Use existing file. Op-
tionally you can create a new data file. For information, see Create a New Data File.

| Note: A wizard is available to record the sample data used to test a business service or

subprogram directly and then export the data to a CSV file. For information, see Export
Test Data to a CSV File.

Select Finish.

The external data unit test file is generated into the Testing-Suites folder (or subfolder) and
listed in the Project Explorer view.

The .exttst file is also displayed in the editor view.

| Note: The .csv file and/or the .nattst/.bsrvtst files may also be created.

Define the configuration settings for the unit test in the editor view.

For information, see Configure Column Mappings and Sample Data.

Select the Connection tab and define the connection settings for the unit test.
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For information, see Define Connections.

8  Save the settings.

Create a New Unit Test

> To create a new unit test

1 Select Create new test in the Source details section on the Define External Data Unit Test
Details panel.

2 Select Next.

The Define New Unit Test Details panel is displayed. For example:

7= New: External Data Unit Test |._|@@
Define New Unit Test Details _—
Enter the settings for a new unit test,
Test details

Mew test name:

(... Testing-Suites/Externalsuite)
Source details

Object type: @ Subprogram O Business service

Object path:
™
@

3 Type the name of the unit test in New test name.

4 Select the object type for the source unit test in Object type.

You can select either Subprogram (the default) or Business service. When Business service
is selected, an additional field is added to the panel. For example:
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7= New External Data Unit Test |:|[E| g|

Define New Unit Test Details 5
Enter besk name m

|~ -

Test details
Mew tesk name:

(... Testing-5uites/Externalsuite)
Source details

Object type: O Subprogram @ Business service

Object path:
Object method: v
by

Select Browse in Object path.

A list of available business service or subprogram unit test files is displayed. Select the unit
test to use for the external data unit test and select OK.

For a business service unit test, select the method to test in Object method.

Select Finish to create the external data unit test and new unit test.
Or:
Select Next to create a new data file.

] Note: This option is only available when Create new file is selected on the Define Ex-
ternal Data Unit Test Details panel.

Create a New Data File

> To create a new data file

Select Create new file in the Source data file (CSV) details section on the Define External
Data Unit Test Details panel.

Select Next.

The Define New Data File Details panel is displayed. For example:
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Define New Data File Details
Enter the settings for a new data File (C5Y),

Diata File (C5%) details
Mew data File name:
(... Testing-5uites/External Suite)
Row details
Delimiter: |,
[CIFirst rows conkains Field names

=]
=]

5

0

|~ -

Cancel

| Note: If Create new test on the Define External Data Unit Test Details panel is also

selected, the Define New Unit Test Details panel is displayed before this panel.

Type the name of the data file in New data file name.

Using this panel, you can:

Task

Procedure

Change the character used to separate
entries in the first row of the CSV file.

Type a new character in Delimiter.

Reserve the first row in the CSV file for
the field names.

Select First row contains field names. At runtime, the first
row in the CSV file is reserved for field names.

Note: When selecting fields for the first row in a CSV file, you

cannot specify the number of occurrences of an array to
include. By default, a maximum of five occurrences of each
array will be included. To add and/or remove occurrences
from the generated CSV file, you must edit the file manually.

Display fields that can be selected for
the first row of the CSV file.

Select Expand All To close the tree view, select Collapse All.

Select fields to be included in the first
row of the CSV file.

Select Select All and then deselect the fields you do not want
toinclude in the CSV file. To deselect all fields, select Deselect
AllL

Select Finish to create the external data unit test, a new data file, and optionally, a new unit

test.
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Configure Column Mappings and Sample Data

This section describes how to map columns in the CSV file (file extension .csv) to fields in the PDA
used by the business service or subprogram unit test. The following CSV file was used for examples:

FHFUNCTION, INPUT-DATA {fFTRST-NUM, INPUT-DATA £SECOND-NUM, TNPUT-DATA.ffSUCCESS-CRITERTA, QUTPUT -DATA AARESULT , QUTPUT-DATA.4/SUCCESS
Add,1,2,3,3,FALSE
Add,1,9,10,10,TRUE

~ To configure column mappings and sample data

1  Select the Configuration tab in the editor for the external data unit test.

For example:

L Calculator, extest 22 =8
Configuration o E @
* General

|nit: test file: ExternalSuite/CALC natkst
Data file (C3W): | ExternalSuitecalculator, csy

Mote: file paths are relative to the Testing-Suites rook Folder,
First row contains Field names

Column delimiters |,

+ Column Mappings

Colurnn Field Marme Index Walidator Criteria

INPUT-DATA, #FLUNMCTION
INPUT-DATA, #FIRST-MIUM
INPUT-DATA, #SECCND-MUM
INPUT-DATA, #5CCESS-CRITERIA
QUTPUT-DATA, #RESULT
QUTPUT-DATA, #35UCCESS

L=y I A P N e

w Sample Data

1 #FUNCTION 21 INPUT-DAT... 3 INPUT-DAT... 41 INPUT-DAT... 5 OUTPUT-DA... & OUTPUT-DA... Refresh

ffdd i E 4 4 FALSE
Add 1 E 10 10 TRUE

Caonfiguration | Connection
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2 Select Add in the Column Mappings section.

The Edit Mapping window is displayed. For example:

7= Edit Mapping g|
Edit Mapping i
Configure mapping entry settings m

= -
Column number: | il |
Field name: | ¥ |
Index: | |
Validatar: | ¥ |
Criteria:

@

The number of the first unmapped column is displayed in Column number. You can change

this number to define the mapping for another column.
3  Select the name of the field to use for this column in Field name.
4  Type the index position in Index (used when the field is an array).
5  Select the type of validator to use for the field in Validator.

The type of validator to use depends on the type of data in the field. The available validators

are:

® BooleanValidator

" ByteValidator

® ComparisonValidator (displays a combo box with the options: ">", "<", "=", "<=", ">=")
® DateValidator

* DecimalValidator

" IntegerValidator

" RegexValidator (creates regular expressions to validate the contents of a field)

= StringValidator

® TimeValidator

6  Select OK.

The new column mapping is added to the list of mappings on the Configuration tab.

7  Continue adding column mappings until all columns used for the test have been added.
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* To revise a mapping, select the mapping in Column Mappings and select Edit. The Edit
Mapping window is displayed to change the mapping.

* To remove a mapping, select the mapping in Column Mappings and select Delete. The
mapping is removed from Column Mappings.

Optionally, you can use the Configuration tab to:

Task

Procedure

Change the name and/or location of
the unit test file used for the external
data unit test.

Type the name of the unit test in Unit test file or select Browse
to display a window listing the existing unit test files for selection.

Note: The unit test must currently exist.

Change the name and/or location of
the CSV file containing field names

and input for the external data unit

test.

Type the name of the CSV file in Data file or select Browse to
display a window listing the existing CSV files for selection.

Note: The CSV file must currently exist.

Reserve the first row in the CSV file
for the field names.

Select First row contains field names. At runtime, the first row
in the CSV file is reserved for field names.

Note: When selecting fields for the first row in a CSV file, you

cannot specify the number of occurrences of an array to include.
By default, a maximum of five occurrences of each array will be
included. To add and/or remove occurrences from the generated
CSYV file, you must edit the file manually.

Change the delimiter character used
to separate columns in the CSV file.

Type a new delimiter character in Column delimiter.

Retrieve sample data from the CSV
file.

Select Refresh in the Sample Data section. The first 20 rows in
the CSV file are retrieved.

Tip: To apply changes to the external data file to the unit test,
use this option with the Map option.

Map new sample data to the
columns.

Select Map (enabled when the First row contains field names
option is selected). A confirmation window is displayed,
indicating that all current column mappings will be removed.
Select Yes to delete the old mappings and apply the new
mappings.

Save the configuration settings.
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This section describes how to create a sequence unit test (file extension .segtst), a type of unit test
that executes a sequence of test steps in a specified order. Each test step executes a business service
or Natural unit test and, optionally, copies data between steps, applies field overrides, defines
validation overrides. and/or applies method overrides (business service unit tests only). These
overrides do not physically change the existing unit test files; the values are only changed in
memory prior to execution of the files.

For example, a sequence test can have the following two steps:

1. Invoke a unit test for a Construct-generated object-maintenance subprogram and attempt to
retrieve (GET) a data record.

2. Re-invoke the same test, but apply a field override that attempts to update the record. In addition,
copy all data from Step 1 and pre-configure each input field.

There are several methods you can use to create a sequence unit test, depending on your require-
ments. These methods include:

® Create one generic business service or Natural unit test and then create a sequence unit test
containing several test steps that reference the same generic unit test, but use a different field
override.

For example, you can create a generic Natural unit test called WAREHOUSE .nattst and then
create a unit test that reference a sequence of unit tests to override the value of WARE-
HOUSE.#FUNCTION, such as WAREHOUSE_GET.nattst, WAREHOUSE_NEXT.nattst, etc.

® Create several business service and/or Natural unit tests that reference the same subprogram/PDA
and then create a sequence unit test that references each unit test in a specified sequence.

For example, you can create a unit test for each warehouse function, such as WARE-
HOUSE_GET.nattst, WAREHOUSE_NEXT.nattst, etc., and then create a unit test that invokes
these tests in a specified sequence.

® Create several business service and/or Natural unit tests that reference different subpro-
grams/PDAs and then create a sequence unit test that references each unit test in a specified
sequence and copies data from one test to the next.

® Create a sequence unit test and one or more unit tests to use for the test.
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Create the Unit Test

This section describes how to use the wizard to create a sequence unit test.

~ To create a sequence unit test

1 Open the context menu for one of the following items in the Project Explorer view:

® Project folder

® Testing-Suites folder or subfolder

" One or more business service and/or Natural unit test files (using standard selection tech-
niques). The tests can reference the same subprogram/PDA or different subprograms/PDAs.
The wizard will create one test step in the generated sequence unit test for each unit test
selected in the Project Explorer view.

2 Select Testing > Create Sequence Unit Test.

The Define Sequence Unit Test Details panel is displayed. For example:

7= New Sequence Unit Test

Define Sequence Unit Test Details

Enter the settings For a new sequence unit kest,

Target
Projeck: MewProject
Parent suite:

Test name:

Display generated file(s)

@)

Py

- BX

=

- -

(default)

Cancel

3  Type the name of the sequence unit test in Test name.

Optionally, you can:
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Task Procedure

Change the name of the project in which|Type the name of the Natural project in Project or select
to create the sequence unit test. Browse to display a window listing the existing projects for
selection.

Note: The project must currently exist.

Provide the name(s) of a subfolder(s) in| Type the name of the folder in Parent suite or select Browse
which to save the sequence unit test. If |to display a window listing the available folders for selection.
the folder does not currently exist, it will

be generated for you. By default, the unit test is stored in the Testing-Suites folder

in the current project. If you specify a suite folder name, it
becomes a subfolder in the Testing-Suites folder and the unit
test will be stored in that folder.

4  Select Finish.

The sequence unit test file is generated into the Testing-Suites folder (or subfolder) and listed
in the Project Explorer view.

The .seqtst file is also displayed in the editor view. For example:

|E Customerlipdate, seqtst &3 =8
Configuration QE @
Test Steps Test Step Details
Define test steps and optional overrides, Set the properties for the selected step or override.

Configuration | Connection

If one unit test file was selected in the Project Explorer view, a default test step is created for
that file. For example:
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Customerlipdate, seqtst 3 =08
Configuration E®
Test Steps Test Step Details
Define test steps and optional overrides, Set the properties for the selected step or override,

Marme: Step_1

Description:

Unit test file: | custamer Tests/MCUSTH . natkst |[ Browse... ]

Copy data

Configuration | Connection

If several unit test files were selected in the Project Explorer view, one test step is created for
each test. For example:

CustomerMaint.seqtst &3 =0
Configuration QE®
Test Steps Test Step Details
Define test steps and optional overrides, Set the properties For the selected skep or averride.
Eag Step, r E Add Marne: Step_1

Eag Skep_2 (Customer_GET.bsrvist) .
- - Description:
Eag Skep_3 (Customer_IMITIALIZE, bsrvst) P
Step_4 (Customer-ByCUSTOMER-NUMEER-BACK WARDS, bsrwtsk)
EEg Skep_5 (Customer-ByCUSTOMER-NUMBER. bsrvtst)

Eag Step_6 (Customer-ByNAME-BACK'WARDS bsrvist) Unit kest file: | cystamer EXISTS.bsrykst | [ Erowse ]
EEg Skep_7 (Customer-ByNAME-wWAREHOIUSE bsrvtst)

Mew. ..

Copy data

Configuration | Connection
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Use the Sequence Unit Test Editor

This section describes how to use the sequence unit test editor. The following topics are covered:

= Add Test Steps

= Copy Data from a Previous Step
= Add an Input Override

= Add a Validation Override

= Add a Method Override

] Notes:

1. For information about the Connections tab, see Define Connections.

2. For general information about using the test editors, see Features of the Test Editors
Add Test Steps

This section describes how to add test steps to execute business service and/or Natural unit tests
in a specified order. Each test step executes one existing unit test and, optionally, copies data
between steps, applies field overrides, and/or defines validation overrides. In the following example,
the sequence unit test is generated from the context menu for a project and no steps are created.
For example:

Customerlipdate seqtst 22 =0
Configuration GQE @
Tesk Steps Test Step Details
Define test steps and optional overrides, Set the properties for the selected step or override,

Configuration | Connection
| Note: To resize the editor sections, select the sash and move it left or right.

> To add test steps

1  Select Add.

The Test Step Details section is displayed. For example:
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|4 *CustomerUpdate, segtst &2

@ Configuration test step'step_

Tesk Steps

Define test steps and optional overrides,

(tn Y

Configuration | Connection

2  Select Browse for Unit test file.

1" Unit test file path is empty,

Remove

=0

Test Step Details

Set the properties For the selected skep or override.

Marne: Step_1

Diescription:
Uniit test file:

Mew, ..
Copy data

The Select Unit Test window is displayed. Select the unit test file and OK. The unit test details
are displayed in the Test Steps section and the selected unit test file is displayed in Unit test

file. For example:

|4 *CustomerUpdate. segtst &2

Configuration

Test Steps

Define test steps and optional overrides,

[Eim Step_1 (Customer_GET.bsrvbst)

Configuration | Connection

Or:

Select New for Unit test file.

Remove

&E®

Test Step Details

Set the properties for the selected step or override,

Marme: Skep_1

Description:
Unit test file: | customer_GET,bsrvtst - Browse.
Copy data

The Select Unit Test Type panel is displayed. For example:
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7= New Unit Test |:| E| Pz|

Select Unit Test Type =
Select the bype of unit kest to create.

|~ -

E.g Business Service Unit Test
Ham Matural Unit Test

\
@

Select one of the following options:
* Business Service Unit Test

The Define Business Service Unit Test Details panel is displayed. For information, see
Create a Unit Test for a Business Service.

® Natural Unit Test

The Define Natural Unit Test Details panel is displayed. For information, see Create a
Unit Test for a Subprogram.

] Note: When accessing these panels from the sequence unit test editor, the project name

defaults to the name of the project containing the sequence unit test and is read-only.
The unit test file specified for each test step must contain a relative path to the Testing-
Suites folder in the project containing the sequence unit test.

After defining the unit test and selecting Finish, the unit test details are displayed in the Test
Steps section and the newly created unit test file is displayed in Unit test file.

3  Select Add.

The second test step is displayed in Test Steps and the Copy data section is enabled. For ex-
ample:
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Iﬂ *Cyustomerlpdate seqtst &9 =0
Configuration QE @
Test Steps Test Step Details
Define test steps and optional overrides, Set the properties for the selected step or override.
EEg Step_1 (Customer_GET.bsrvkst) Mame: Step_2
! (Customer_GET.bsrvEst) Description:
Unit test file: | customer_GET,bsrvtst -m
Mew, ..
Copy data

[ Copy the data fram a previous step

Configuration | Connection

4  Select or create the unit test for the second test step.

Repeat steps 1 and 2 until all test steps have been added. Optionally, you can use this editor

to:

Task Procedure

Provide a description of this test step. Type a description of the test step in Description
(maximum of 250 characters). The first 60 characters
are displayed as the tool tip for the test step in Test
Steps.

Copy data from a previous step. See Copy Data from a Previous Step.

Delete a test step. Select the test step in Test Steps and select Remove or
open the context menu for the test step and select
Delete.

Reorder the test steps. Select the test step in Test Steps and select Up or Down.

Provide a name for the test step. Type the step name in Name.

Define an input override for a field used in a |See Add an Input Override.

test step.

Define a validation override for a field used |See Add a Validation Override.

in a test step.

Define a method override for a method used |See Add a Method Override.

in a test step (business service unit tests only).

5  Save the settings.

Application Testing 95



Create a Sequence Unit Test

Copy Data from a Previous Step

This section describes how to copy data from a previous test step. When the generated sequence
test is run, the test step will attempt to copy the data from the specified test step. If the test steps
share the same Natural unit test file, the entire data structure from the previous test step is copied.
If the test steps use different Natural unit test files, each field is copied by name and the level 1
name (if present) is compared to the field name.

@ Caution: Allvalues are copied, even when the Natural formats are different. This may result

in conversion errors (for example, when alpha values are placed in numeric fields).

> To copy data from a previous test step

1  Select the test step to which you want to copy the data.
2 Select Copy data from a previous step.

3 Select the test step from which you want to copy the data in Step name.

You can select any previous test step in the list. Only previous test steps are listed, as data
cannot be copied from a test step that has not been run.

Note: When defining input or validation overrides, you can also select the field from
which to copy the data.

Add an Input Override

This section describes how to add an input override for a field. This value will override any input
value defined for an input field with the same name in the original unit test file. For example, if
the original unit test file has an input field and value of FUNCTION=GET and you add an override
to a test step that sets FUNCTION=UPDATE, then FUNCTION=UPDATE will be used.

> To add an input override

1 Open the context menu for the test step in Test Steps.
2 Select New > Input Override.

The field details are displayed in Test Step Details. For example:
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*CustomerUpdate.seqtst &3 =0
Configuration G E @
Tesk Steps Test Step Details
Define test steps and optional overrides, Set the properties for the selected step or override,
= EE!E_EED—I {Cuskomer Tests/MCUSTN_GET nattst) Field name: | CUSTOMER, CUSTGMER-NUMBER v
T CLSTO ' CLISTOMER -MUMEBER.
il ER.. CUSTCOMER-MUMEE
[Ey step_2 (Customer Tests/MCUSTN_NEXT nattst) Index:
Yalue:
Copy data

Configuration | Connection

3  Type the override value in Value.

The input override is displayed in Test Steps. For example:

*Customerlipdate. seqtst &2 =
Configuration QE®@
Test Steps Test Step Details
Define test steps and optional overrides, Sek the properties for the selected step or override,

=) (Bl Step_t (Customer TestsjMCUSTN_GET.nattst) Field name: | CUSTOMER..CISTOMER-MUMBER v
B CUSTOMER CUSTOMER-NUMBER ('111)

[Egw step_2 (Customer Tests/MCUSTH_NEXT nattst) Index:

Yalue: 111

Copy data

Configuration | Connection

In this example, an override value for the CUSTOMER-NUMBER field has been added.

] Notes:

1. For information about the input parameters, see Configure Input Parameters.

2. You can copy the field data from a previous step. For information, see Copy Data from a
Previous Step.

3. To remove an input override, either select the override in Test Steps and select Remove
or open the context menu for the override and select Delete.
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Add a Validation Override

This section describes how to add an override value for a field validation. This value will override
any validation defined for an input field with the same name in the original unit test file. For ex-
ample, if the original unit test file has a field validation of #MSG <> ERROR and you add a validation
override of #fMSG <> WARNING, then both validations will be used (i.e., the wizard will ensure that
the message is not equal to both ERROR and WARNING).

> To add a validation override

1 Open the context menu for the test step in Test Steps.
2 Select New > Validation Override.

The validation details are displayed in Test Step Details. For example:

|4 *CustomerUpdate.seqtst &3

=8
Configuration QE®@
Test Steps Test Step Details
Define test steps and optional overrides, Sek the properties for the selected step or override,
=I-[Ejg Step_t (Customer TestsjMCUSTN_GET.nattst) Field name: | CUSTOMER..CISTOMER-MUMBER v
ILa d v
'#¥ CUSTOMER ,CUSTOMER-MUMBER ('111%)
o/l CLISTOMER , CUSTOMER -NUMBER. (") Index:
&
lEgm Step_2 (Customer TestsMCUSTN_MEXT .nattst) yalidator: | Stringvalidator “w

Yalue:

Configuration | Connection

3  Select the field name in Field name.

4  Select the override value in Validator.

The validation override is displayed in Test Steps. For example:
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| *CustomerUpdate seqtst &2

=0
Configuration QE @
Test Steps Test Step Details
Define test steps and aptional overrides. Set the properties for the selected step or override.
&
= [eis Step_L (Customer Tests/MCUSTN_GET.nattst) Field name: | CUSTOMER, CUSTOMER-TIMESTAMP v

| CUSTOMER. CUSTOMER-NUMBER ('1117)

18 CLSTOMER.CLISTOMER-TIMESTAMP (May 11, 2012 06:11:33.900 PM) Index:
Eh Step_2 {Customer Tesks/MCUSTM_MEXT.natkst)

‘alidator: imeYalidator
Date: siijzolz
Value: Time: Gi11:33PM 3

Fraction: | 9

Corfiguration | Connection

In this example, an override validation for the CUSTOMER-TIMESTAMP field has been added.

] Notes:

1. For information about the validation parameters, see Define Validations.

2. You can copy the validation data from a previous step. For information, see Copy Data
from a Previous Step.

3. To remove a validation override, either select the override and select Remove or open the
context menu for the override and select Delete.

Add a Method Override

This section describes how to add a method override value for a business service unit test. This
value will override the method name in the original business service unit test. For example, if the
original unit test has a method value of "BROWSE" and you add a method override value "EXISTS"
to a test step, then the sequence unit test will execute the "EXISTS" method.

> To add a method override

1 Open the context menu for the test step in Test Steps.
2 Select New > Method Override.

The method details are displayed in Test Step Details. For example:
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[ *CustomerMaintenance.seqtst 53 =0
Configuration QE @
Tesk Steps Test Step Details
Define test steps and optional overrides. Set the properties For the selected step or override,
Eag Step_1 {(Customer TestsMCUSTM_EXISTS.nattst) Method: |BROWSE 2

EE! Step_2 {Customer TestsMCUSTN_GET.nattst)
EE! Step_3 {(Customer TestsMCUSTM_INITIALIZE. nattst)
= E&g Step_4 (Customer-By CUSTOMER-MUMEER-BACKWARDS. barvtst)

EE! Step_6 {(Customer-ByNAME-BACKWARDS, bsrvtst)
Eﬂg Step_7 {(Customer-ByMNAME-WAREHOUSE bsrvtst)

Configuration | Connection

3  Type the override value in Method.

The method override is displayed in Test Steps. For example:

| *CustomerMaintenance. seqkst 52 =0
Configuration G E @
Test Steps Test Step Details
Define test steps and optional overrides. Set the properties for the selected skep or owerride,
[ Step_1 (Customer Tests/MCUSTN_EXISTS,nattst) Method: [

E&g Step_2 {Customer TestsMCUSTN_GET.natkst)
EE! Step_3 {Customer TestsMCUSTN_INITIALIZE. nattst)
= EE! Step_4 {Customer-ByCUSTOMER-MUMBER-BACKWARDS, bsrvist)
¥ Method (EXISTS)
EE; Step_5 {Customer-ByCUSTOMER-MUMBER., bsrvtst)
Eﬁg Step_6 {(Customer-ByMNAME-BACKWARDS bsrvtst)
EE! Step_7 {Customer-ByMNAME-WAREHOISE  bsrvst)

Configuration | Connection

In this example, an override value of METHOD=EXISTS has been added.

] Notes:

1. For information about business service methods, see NaturalONE's Business Services docu-
mentation.

2. To remove a method override, either select the override in Test Steps and select Remove
or open the context menu for the override and select Delete.
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Use the Dependencies View

When a generated module is open in the editor, the Dependencies view displays dependencies
between a sequence unit test and the unit tests executed for each test step. This section describes
the nodes contributed to the view for these resources. The following topics are covered:

= Sequence Unit Test Resources
= Business Service Unit Test Resources
= Natural Unit Test Resources

] Notes:

1. Select 1% to sort the resources alphabetically.
2. Select w4 to export a textual representation of the visible nodes in the view to a file.

3. When a supporting resource cannot be found locally using the project steplib chain and project
references, "<Unknown>"is displayed with the name of the resource. If the unknown module(s)
is not shipped with the Construct runtime project, either manually download it from the server
or create it locally. If the module(s) is shipped with the Construct runtime project, add the
project. For information, see NaturalONE's Code Generation documentation.

4. For more information about the Dependencies view, see the description of the source editor
in Using Natural ONE.

Sequence Unit Test Resources

When a sequence unit test is open in the editor view, the root node displays the name of the se-

quence unit test. In caller mode ( “a)), no child nodes are displayed because no other Dependencies
view objects depend on this sequence unit test file. For example:

?—E Dependencies i3 o | ®a|Y%m|%ed T O
[ icustomer Tests:CustomerUpdate:

In callee mode (“=)), the child nodes display one business service or Natural unit test for each test
step in the sequence unit test. For example:
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?—E Dependencies &3 = | Sg|%|l% e T O

= g8 Customer Tests:CustomerUpdate
+ygm Custamer Tests:MCUSTH_INITIALIZE
g Custorner Tesks:MCUSTH_GET
N Customer TestsiMCUSTN_STORE
Him Custarner Tesks:MCUSTHN_MERT
N Custormer-ByCUSTOMER-NUMBER-BACKWARDS
N Customer Tests:MCUSTH_EXISTS
Ham ACUSTN-ByCUSTOMER-NUMEBER-BACKWARDS
N Customer TesksiMCUSTN

RN O A e R e e

Business Service Unit Test Resources

When a business service unit test is open in the editor view, the root node displays the name of

the unit test. In caller mode (")), one child node is displayed for each sequence unit test that in-
cludes this unit test in one of its test steps. For example:

?—E Dependencies &2 = Sg|%|l%ed O
= iz iCustomer-ByCLISTOMER-NUMEER-BACKWARDS

{Ei@ Customer TestsiCustomer Maintenance
{Ex® Customer Tests:CustomerUpdate

In callee mode (“=)), the child node displays the name of the business service that the unit test ex-
ecutes, along with the names of the supporting Natural resources and the names of the libraries
and projects in which they are located. For example:

?—E Dependencies i3 o | Sa| %% ed T O

=\ Customer-ByCLISTOMER-NUMBER-BACK WARDS
=[5 DEMO: Customer.v1.1.1
*§iH DEMOTEST:ACUST
#1-{ DEMOTEST:MCUSTY
#-§ DEMOTEST:MCUSTH

Natural Unit Test Resources

When a Natural unit test is open in the editor view, the root node displays the name of the unit

test. In caller mode (=), one child node is displayed for each sequence unit test that includes this
unit test in one of its test steps. For example:
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?—E Dependencies &3 = S |Y%|l%ed T O
= gk iCustomer TestsiMCUSTN_EXISTS |
|Egd Customer Tests:OrderlUpdate
|Egd Customer Tests: CustomerUpdate
|Egd Customer Tests:Wwarehousellpdate

In callee mode (&), the child node displays the name of the Natural subprogram that the unit
test executes, along with the names of the supporting Natural resources and the names of the lib-
raries and projects in which they are located. For example:

?—E Dependencies &3 = | Sg|%|l% e T O

= g iCustomer Tests:MCUSTN_EXISTS |
= {Ff DEMOTEST:MCUSTH

2€ DEMOTEST:MCUSTA
DEMOTEST:MCUSTR
SYSTEM:CDAOEIZ {ConstructRuntime}
DEMOTEST:CDPDA-M ajaxProject
YSTEMMCST-CUSTOMER
Y STEMIMCST-WAREHCLSE
YSTEMIMCST-INS-POLICY
YSTEM:NCST-ORDER-HEADER
WSTEMCCESCAPE {ConstructRuntime}
WATEMCCDBCALZ {ConstructRuntimel
CBIECT-MAINT-SLUEP

W ONO YO Y O[T [l [ |
ARARARARARARAR,

il

W oW oW wowm

=]

+
=4
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10 Test an External Subroutine
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Test an External Subroutine

This section describes how to test an external subroutine. The tester can test the subroutine using
either a subprogram or a program that calls a subprogram. The following tables describes which
option to use:

External Subroutine Features Test Using

No parameters and screen Program (Natural for Ajax provides the screen input/output)
input/output

Parameters and no screen Subprogram (then you can use the subprogram tester to create scripts
input/output so the tests can be run again)

Note: If there are parameters and no screen input/output, it is easier

to test the routine as a subprogram because the subprogram tester
can handle the variety of parameters.

Regardless of which option you use, temporary Natural objects are created to perform the tests
and then deleted when the Natural for Ajax page or subprogram tester is closed.

| Note: If you intend to use the temporary subprograms to create a unit (batch) test for the

subroutine, save the files locally before closing the tester.

Access the Subroutine Tester

> To access the subroutine tester

1 Open the context menu for the subroutine in the Project Explorer view.

2 Select Testing.

The test options for external subroutines are displayed.

Test with a Program

~ To test an external subroutine using a program

1 Open the context menu for the subroutine in the Project Explorer view.

2 Select Testing > Test Subroutine with Program.

The subroutine is tested and the results are displayed in the Natural I/O view. For example:
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O Natural /o 3 =0

Matural Web 10 Output

Hello ||_

[St?le Sheet

Test with a Subprogram

~ To test an external subroutine using a subprogram

1 Open the context menu for the subroutine in the Project Explorer view.

2 Select Testing > Test Subroutine with Subprogram.

The tester creates a temporary subprogram file to test the subroutine. For example:

{38 TSO1506T 52 =0
Property Walue
= Misc
1oL #8 (A3 InOut
Mame #4
= Value

Yalue

Drata | Conneckion

] Note: This editor functions in the same way as the editor used to test a subprogram.

For information on using this editor, see Features of the Test Editors and Test a Sub-
program Directly.
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11 Test a Natural Map

This section describes how to test a Natural map in NaturalONE. The tester allows you to test a
map as you would on the server (i.e., pressing PF4 in the map editor).

| Note: The map must be available locally. If the map is not available locally, download it

from the server.

~ To test a Natural map

1 Open the context menu for the map in the Project Explorer view.
2 Select Testing.
3 Select Test Map.

The output of the map is displayed. For example:
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Test a Natural Map

(3 Matural Ifo &3

Natural Web I/0 Output

HCMATH

Tode Bubsystem

Direct Command:

Ertcer-FFL---FFi---FF#---FF4---FF§---FFE---FF7---FF#- --FF9- - -FFL0- -PF11--FFli---

[St-,rle Sheet

In addition to testing the output of the map, you can also test all code within the map. For
example, you can enter "?" in an input field to display the available help information (if help

has been attached to the map).

You can also apply a different style sheet to the map by selecting » in Style Sheet. For example:
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(@ Makural Ifo &3

Natural Web [/0 Output

HCRRIEY

Tode Subsystem

Direct Command:

Enter-PFL---FF2 - --PF3- --PP4-- -FF§ - - -FF6 - - -FF7 - - -FP§- - -FF4---FFL0--FF11--FFLé- - -

Style Sheet

=
Weh [/O style sheet: natural.css hd Apply

In this example, the default style sheet natural.css has been used. If you would like to see the

same colors in the output window as in the map editor, you can use the style sheet natural_ma-
peditor.css instead of the default style sheet.

To change style sheets, select the file in Web I/O style sheet and select Apply. The map is
redisplayed with the selected style sheet.
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Setting Preferences for Application Testing

This section describes how to set preferences for the supplied test function.

Showing the Preferences for Application Testing

The preferences for Application Testing are set in the Preferences dialog box of Eclipse.

~ To show the preferences for Application Testing

1  From the Window menu, choose Preferences.

2 In the tree of the resulting dialog box, expand the Software AG node and then select the
Testing node.

The Testing page is displayed.

. -
= Preferences |

O-E-B-E-B-B-E-B-E-E-B-E- BB

General
ank
Cenkrasite
Data Management
Help
Installf/Update
Java
Jawva EE
Jawva Persistence
Javascript
Plug-in Development
Report Design
Run/Debug
Server
Software AG
Ajax Developer
Business Services
Code Generation
Construct
Entirex
Matural
Predict Description and Generation
Request Document
UDDI Registries
Web Services Stack,

S

Testing

Lnit kest preferences
[]Log unit tests

BT

- BX

Upload resourcels) when they are not in sync with server

O always ) Mever

@ Prompt

[Restore Defaulks ] [

Apply

)

Lo JI

Cancel

)

14
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Set Logging Preferences for Unit Tests

~ To set logging preferences

1  Display the Testing page as described above.
2 Select Log unit tests.

Unit test log files will be created automatically each time a unit test is executed. The log files
are stored in the Testing-History folder within the NaturalONE project in which the unit test
was executed and include a .tstlog file extension.

Note: If this option is not selected, the log files will not be created.

3 Select OK to save the preferences.

Set Server Synchronization Preferences

When testing a subprogram, a message may be displayed indicating that a local resource has not
been uploaded to the server and synchronized with the server resource. You can set preferences
for this option.

~ To set server synchronization preferences

1  Display the Testing page as described above.

2 Select one of the options listed in Upload resource(s) when they are not in sync with server.

These options are:

Option (Description

Always|Resource(s) are always uploaded to the server when not in sync.

Never |Resource(s) are never uploaded to the server when not in sync.

Prompt|A window is displayed to select an option.

3 Select OK to save the preferences.
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Creating Ant Scripts to Run Unit Tests

You can use the Natural Unit Test Ant Script wizard to create XML-based Ant scripts to run unit
test files (file extension .exttst, .nattst, and .seqtst). You can run the Ant script from within Natur-
alONE or from the command line.

| Note: Itis not possible to run business services via the Natural Unit Test Ant Script.

For information on creating unit test files, see:

® Create a Unit Test for a Subprogram
® Create an External Data Unit Test

® Create a Sequence Unit Test

General Information

NaturalONE offers a Natural Unit Test Ant Wizard which collects all required information (such
as the Natural project where the tests are located or the RPC environment to be used) and writes
it to an Ant script which is finally used to run the Natural unit tests. This Ant script makes the
testing task highly configurable and repeatable and allows you to run the tests unattended.

This Ant-based Natural unit testing can either be started from within the NaturalONE Eclipse
environment or via the Ant command line utility. It provides the following functionality:

® Run Natural unit test cases available in a root folder hosting the project.

® Check out a Natural project with Natural unit test cases and required Natural sources from a
version control system (either CVS, Subversion or Git); this is usually done outside of Eclipse.

Using the Natural Unit Test Ant Script Wizard to Run Natural Unit Tests

The Natural Unit Test Ant Script wizard creates a Natural test file in your project root folder for
executing Natural unit tests. This is an Ant script. You can create one or more Natural test files
for a project, and you can also load an existing Natural test file and modify the current settings.

> To use the Natural Unit Test Ant Script wizard

1  In the Project Explorer view or in the Natural Navigator view, select the Natural project for
which you want to create the test file.

Or:

If you want to load the settings of an existing Natural test file, select this file in the Project
Explorer view or in the Natural Navigator view.
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2 From the File menu or from the context menu, choose New > Other.

3 Inthe resulting New dialog box, expand the Software AG node, then expand the Testing
node, select Natural Unit Test Ant Script and finally click the Next button.
The first page of the wizard (General Settings) appears.

4  Specity all required information as described individually for each wizard page in the following
sections below. Use the Next button repeatedly to proceed from the first page of the wizard
to the last page.

5  When all required information has been provided, click the Finish button .
= General Settings
= Repository
= | ogging

General Settings

On the first page of the wizard, you define general settings for the Natural unit testing.
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& New Natural Unit Test Ant O pd

Create a Natural Unit Test Ant Script
This wizard creates a Natural Unit Test Ant Script

Project: | UnitTests2 Browse...

Matural Unit test ant file selection

Matural Unit test file: | unittest.xml Browse... Loadfrom File @ Load Defaults

Environment

Rpc environment: Natural RPC Server v

[[] Enable fail-on-error for Ant script

Root directory: P:\oned1\NatUnit Browse...
(2 < Back Next > Finish Cancel
Project
The project which contains the Natural unit test cases and required Natural sources.
Natural Unit test file

The default name for the Natural unit test file is unittest.xml. This name is shown in this text

box when an existing Natural test file was not selected while invoking the wizard. However,
when an existing Natural test file was selected, the name of the selected file is shown and the
settings from this file are automatically loaded.

You can enter any other name for your new test file. It is recommended that your new test file
also has the extension .xml.

D Notes:
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1. If you keep the name unittest.xml, the settings from an existing Natural test file with the
same name are loaded the next time you select the project and invoke the wizard.

2. If you want to load an existing Natural test file, choose the Browse button. A dialog appears,
providing for selection of all Natural test files in the current project. Next, you have to
choose the Load from File button. Otherwise, the settings in this file are not shown in the
wizard and may thus be overwritten unintentionally.

3. If you want to return to the default settings of the test wizard (this also includes the inform-
ation that can be specified on the other pages of the wizard), choose the Load Defaults
button.

RPC Environment
You can select the RPC environment which should be used to run the Natural unit tests. An
RPC environment can be defined in the RPC Environment monitor of the EntireX perspective.
For more information, refer to the EntireX documentation.

The wizard creates all required RPC properties such as Broker ID or Server Address into the
test file.

Enable fail-on-error for Ant script
When enabled, the Ant script reports errors and terminates in the case of a build failure.
When disabled, the Ant script still reports errors but does not terminate.

Root directory
This path should only be changed when you intend to start the Natural unit testing from the
command line (that is, when the Natural unit testing is not to be started from Eclipse).

Specify the directory in which the selected project is to be checked out and where the processing
takes place. When the testing is supposed to run on a different machine, you can insert the
desired root path using copy and paste.

Repository

On this page of the wizard, you define all settings related to the versioning repository. This can
be either Subversion (SVN), Git or CVS.
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& New Natural Unit Test Ant O X
| Create a Natural Unit Test Ant Script -
| Repository |
= |
Repository
Type: SVN v
PSENVEr.
URL: http://natcvs/repos/nfnqa/dev/91/projects/Testing/UnitTests2
UnitTests2
Version: HEAD
User ID: uid)|
Password: . TITTIIIITIITIL]

Enable password encryption

‘ |_"':?". < Back MNext > Finish Cancel

Type
From the Type drop-down list box, select the type of versioning repository that you are using,
and then specify all required information. The names of the text boxes and their availability
changes according to the selected type.

The wizard usually collects a set of default information as given for the selected project. In
most cases, only minor corrections have to be made to the defaults, for example, user ID and
password may have to be provided

Enable password encryption
When enabled, the repository password that is used in the Natural unit test file is stored in an
encrypted format.
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Logging

On this page of the wizard you can write history files or specify a log file for generating a Junit

compatible Test Report.

& New Natural Unit Test Ant O X
Create a Natural Unit Test Ant Script =

Logging =

Legging

Write history files

Log file name: | logxml
Lx?/' < Back Next > Finish Cancel
Write history files

If enabled, a history file is written to the Testing-History folder of the project any time the

Natural unit test file is run.

Log file name

The name of a JUnit-style Test Report. For further information please refer to Generating a

JUnit-style Test Report.
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Generating a JUnit-style Test Report

Usually, when running the Natural unit test script from within Natural ONE or from the command
line, the standard output of the script is sufficient to determine the outcome of the test as well as
the errors that might have happened in single test steps during the run. However, when the test

is run within a continuous integration tool like Jenkins or Hudson, a different output style might
be desirable. Itis possible to enable an additional JUnit-style output for the Natural unit test script.
While the standard console output remains the same, an additional file is written which can then
be used for example as the input file for a JUnit post-build action.

To switch on additional JUnit-style output, the Natural unit test Ant script has to be launched
with an Ant listener:

ant ... -listener «
com.softwareag.natural.unittest.ant.framework.NaturalTestingdunitlLogger

The JUnit-style output will then be written to a file named log.xml. The name of the file can be
changed.

The resulting file can be used as input, for example in the Publish JUnit test result report post-
build action in a Jenkins job.

Running the Natural Unit Test Ant Script from NaturalONE

When you start the Natural unit test Ant script from Eclipse, it is not possible to execute the
checkout target of the Ant script since this target would access the versioning repository, and this
is not feasible from within an Eclipse environment. If you want to check out a specific revision
from the versioning repository, you have to start the Natural unit test Ant script from the command
line as described in Running the Natural Unit Test Ant Script from the Command Line.

However, for testing purposes it is helpful to start the Natural unit test Ant script from Eclipse.
Since the Natural unit testing file is an Ant script, the built-in Eclipse functionality of starting Ant
scripts is used here. The unittest target (which is the default target) of the Ant script will then be
executed.

~ To start the Natural Unit Test Ant script from Eclipse

= In the Project Explorer view or in the Natural Navigator view, select your Natural unit test
file, invoke the context menu and choose Run As > Ant Build.

The Natural unit test process is started and the output test run is written to the Console view.
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) Notes:

1. If you want to change the limit for the console output, you can do this in the general Eclipse
preferences under Run/Debug > Console.

2. If you want to generate a Junit-style test report from within Eclipse you must choose Run
As > Ant Build... and configure the arguments and the class path accordingly.

Running the Natural Unit Test Ant Script from the Command Line

You can start the Natural unit test Ant script from a Windows command line such as the Command
Prompt (cmd.exe) or from a shell command line on a Linux system. When you start the Natural
unit tests from the command line or shell, special requirements must be met.

= Prerequisites
= Starting Ant based Natural Unit testing
= Example

Prerequisites

The following components must be installed and accessible:

" Apache Ant 1.7.1 or above.
® Java Development Kit (JDK) 11 or above.

® If you want to use the Ant checkout task of the Natural Unit Test Ant script, the corresponding
repository tool has to be installed (either the Subversion command line tool 1.5.2 or above, the
CVS command line tool 1.11 or above, or the Git command line tool 1.9.5 or above)

You have to copy the following JAR files, which contain the necessary processing code, from the
NaturalONE Eclipse installation to the new directory:

" com.softwareag.entirex.core_<version>.jar

" com.softwareag.entirex.runtime_<version>jar

" com.softwareag.natural.unittest.ant_<version>jar

" com.softwareag.natural.unittest.core_<version>.jar

" com.softwareag.naturalone.natural.auxiliary_<version>.jar

" com.softwareag.naturalone.gen.common.logging <version>.jar

® com.thoughtworks.xstream_<version>jar

® org.apache.logdj.api_<version>jar

" org.apache.logdj.core_<version>jar
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Where <version> represents the corresponding version number that is part of the JAR file name.

You have to copy your Natural unit test file which has been created by the Natural Unit Test Ant
wizard into the directory which has been specified in the wizard as the root directory (this is the
base directory for processing).

Starting Ant based Natural Unit testing

When all prerequisites are in place, the Natural unit testing can be started by issuing specific Ant
calls. (where the default name unittest.xml is used).

® Print the help screen of the Natural Unit Test Ant script:

ant -1ib path-to-mylib -buildfile unittest.xml help

® Perform an initial checkout of the project containing the Natural unit tests from the versioning
repository:

ant -1ib path-to-mylib -buildfile unittest.xml checkout
® Perform Natural unit test run with a Junit-style log file:

ant -1ib path-to-mylib -buildfile unittest.xml -Tistener <
com.softwareag.natural.unittest.ant.framework.NaturalTestingdunitlLogger

Example

The following sections describe how to run Ant-based Natural unit tests from the command line:

= Contents of the root folder

= Modification of the Ant Script unittest.xml

= Checkout the Project from repository

= Run the Ant Script

= Console result of the Natural Unit Test Run
= JUnit-style log file has been created
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= Display the log file with JUnit View
Contents of the root folder
In this example, the folder P:\ NatUnit contains the Natural ONE bundles required for Natural unit

testing. The path to the Ant binaries must have been set. In addition to the .jar files, the Ant script
unittest.xml is also available in this folder.

B Command Prompt - O *

:\NatUnit>dir
Volume in i
Volume Serial Number

Directory of P:\NatUnit

<DIR>

:\NatUnit>_

Modification of the Ant Script unittest.xml

In order to run the Ant based Natural unit testing script from a specific root folder, to checkout
from a specific repository site, or to use a specific project name, the following adjustments are
applied in the file unittest.xml:

" natural.ant.project.rootdir value="P:\NatUnit"

" natural.ant.project.name value="UnitTests2"

" natural.ant.repository.module value="UnitTests2"
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Checkout the Project from repository

The project UnitTests2 will be checked out from an SVN repository using the following command
at the command prompt:

ant -1ib P:\NatUnit -buildfile unittest.xml checkout

After the checkout task has been run, the Natural project UnitTests2 is now also available as a
subdirectory in the root folder P:\ NatUnit.

468.175 com.sottwareag.naturalone.natur
67 4 com.thoughtworks.xstream_1.4
381 2 org.apache.logging.logdj.api_2

1.796.452 org.apache.logging.logd]j.core_2
28.189 wunittest.xml

o

9.227

:\NatUnit>»
Run the Ant Script

In the next step, the Ant script is running the tests located in the UnitTest2 project. It is using an
Ant listener to write a JUnit-style log file in addition to the console output. The unittest taskis
not explicitly specified in the command line, since this task is the default task:

ant -1ib P:\NatUnit -buildfile unittest.xml -Tistener «
com.softwareag.natural.unittest.ant.framework.NaturalTestingdunitlLogger

Console result of the Natural Unit Test Run

The console shows the results of the test run. The single test case SECTEST1 has been run success-
fully.

[testsuite] Test suite started
[testsuite] Started: UnitTests2
[testsuite] Started: SECTEST1l.nattst
[testsuite] Passed: SECTEST1l.nattst

[testsuite] Passed: UnitTests2
[testsuite] Tests: 1 Failed: ©

BUILD SUCCESSFUL
otal time: 1 second
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JUnit-style log file has been created

The file log.xml with the JUnit compatible format has been added to the root folder P:\ NatUnit.

Directory of P:\NatUnit

ore_16.9.9.9888-8219. j
untime_16.9.8.80860-0
al.unittest.ant ¢ 1.068008-
natural.unitte .2.1.80080-8124. jar
aturalone.ger

=

Display the log file with JUnit View

The log file is displayed inside Eclipse with the JUnit view:

lerI-IJa.t :: %] el 8 E: * : ﬁ
UnitTestz2

Runs: 1/1 B Errors: 0 B Failures: 0

v ft] UnitTests2 = Failure Trace .

e| SECTEST1.nattst (0.669 5)

Properties of the Natural Unit Test Ant Script

This section describes the Ant properties that the Natural Unit Test Ant wizard generates into the
Natural unit test Ant script. Some properties can be modified according to specific needs. However,
in most cases it will be sufficient to just adapt the natural.ant.project.rootdir property since
the wizard assigns the Eclipse workspace path to this property.
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Property Description

natural.ant.project.rootdir The root folder where the project containing the Natural unit test cases is loc
Unit Test Ant wizard always assigns the Eclipse workspace path to this prc

natural.ant.project.name The name of the project containing the tests. Apart from the various test ca
.nattst, and .seqtst all Natural sources relevant for constructing the IDL of a ca
must be available.

natural.testing.ant.rpcpwd The encrypted RPC password.

natural.testing.ant.rpcuid The RPC user ID.

natural.testing.ant.rpcenvname The name of the RPC environment.

natural.testing.ant.srvaddr The RPC address string.

natural.testing.ant.file.name The name of the Ant script.

natural.testing.ant.brokerid The used Broker.

natural.testing.ant.exxpwd The encrypted EntireX password.

natural.testing.ant.exxuid The EntireX user.

NaturalTestingdunitLogger.file

The name of the JUnit-style logfile.
The default is log.xml. A fully qualified path could also be entered.

The log file will only be generated when the ant listener
com.softwareag.natural.unittest.ant.framework.NaturalTesti
is set.

natural.

ant.project.

steplibs

The steplib chain.

This chain is just used for finding the Natural sources involved in construct
passed to the Broker/RPC environment but will not be used for passing the
RPC runtime environment. As a consequence all Natural sources like para:
must be available in the Natural unit test project.

natural.

ant.referenced.projects

The projects referenced by the Natural unit test project. The defaultis "".
If specified, the referenced projects must also be checked out. Referenced pro
during test case execution to potentially find a required Natural source like
area in a library of a referenced project.

natural.

testing.ant.

logon

Logon to the broker in order to perform authentication. The default is YES.
mandatory for secured Broker/RPC environments.

natural.

ant.failonerror

The Ant processing terminates after the first error. The default is NO.

natural.

testing.ant.writehistory

Writes history files to the fixed folder Testing-History located under the pr
default is NO.

natural.ant.project.password.encryption|Enables repository password encryption. The default is YES.
natural.ant.repository.version The version to check out from the repository.
natural.ant.repository.type The repository type.
natural.ant.repository.password The repository password.
natural.ant.repository.username The repository user.
natural.ant.repository.access.method The repository access method.
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Property Description
natural.ant.repository.ur The URL of the repository.
natural.ant.repository.module The name of the project to check out from the repository.

Migrate Existing Natural Unit Test Ant Scripts

As of NaturalONE version 9.2.1, Code Generation logging is based on Apache Log4j 2 instead of
Apache Log4;.

For this reason, the natural.ant.searchpath property in Creating Ant Scripts to Run Unit Tests
has been changed. If you create a new Natural Unit Test Ant Script, the correct
natural.ant.searchpath will be generated. However, if you have Natural Unit Test Ant scripts
in your Natural Projects directory created with Natural ONE before version 9.2.1, you must migrate
these scripts to the new format.

= Migrate Natural Unit Test Ant Scripts from within the NaturalONE Eclipse Environment
= Migrate Natural Unit Test Ant Scripts from the Command Line

Migrate Natural Unit Test Ant Scripts from within the NaturalONE Eclipse Environment

~ To migrate the Natural Unit Test Ant scripts

1  In the Project Explorer view or in the Natural Navigator view, select the Natural project for
which you want to migrate scripts.

2 Invoke the context menu and choose Testing > Migrate Natural Unit Test Ant Scripts.

3  Inthe Migrate Natural Unit Test Ant Scripts dialog box, all projects which contain scripts
with the old format will be listed. The projects which are selected will be migrated.

4  Select all projects you want to migrate or select Migrate all to migrate all listed projects. Then
click Migrate.

5  The Natural Unit Test Ant scripts will be migrated to the current format and a backup file
with the .bck extension will be created for every migrated script (e.g. unittest.xml.bck).
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& Migration Matural Unit Test Ant Scripts O d

The Matural Unit Test Ant Scripts listed below have an old format which is no lenger
supported with the current version of Matural OMNE. It is necessary to migrate these
files before using them with this version of Matural OME.

w []1= Test.Arithmetic
[] %] unittestaml

w UnitTests
unittestaml

v [] UnitTests2
[] %] unittestaml

v [] UnitTests2-secured-broker
[] %] unittestaml

v [] UnitTests-OLD-FORMAT
[] %] unittestaml

Migrate Natural Unit Test Ant Scripts from the Command Line

You can start the Natural Unit Test Ant script migration from a Windows command line such as
the Command Prompt (cmd.exe) or from a shell command line on a Linux system. When you start
the migration from the command line or shell, special requirements must be met.

= Prerequisites
= Start Migration

Prerequisites

® Java Development Kit (JDK) 11 or above

Copy the following JAR file, which contains the necessary processing code, from the Natural ONE
Eclipse installation to the new directory:

" com.softwareag.natural.unittest.ant_<version>jar

Where <version> represents the corresponding version number that is part of the JAR file name.
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Start Migration

When all prerequisites are in place, the Natural Unit Test Ant script migration can be started by
issuing specific java calls.

® Print the help screen:
java -jar com.softwareag.natural.unittest.ant_<version>.jar

® List all scripts with old format on the given path:

java -jar com.softwareag.natural.unittest.ant_<version>.jar <
findAntUnitScriptsToMigrate <Path_to_search>

® Migrate all scripts with old format on the given path:

Java -jar com.softwareag.natural.unittest.ant_<version>.jar <
migrateAntUnitScripts <Path_to_search>
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